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Before Use

Introduction

Congratulations on the purchase of your new AmScope microscope camera!

This manual is designed for the MU camera series.

Please be sure to take a few minutes to familiarize yourself with the features and functions of 
your new AmScope microscope camera.

If you’d like more information on microscopes, parts, or accessories, please visit our website at:

www.amscope.com

We highly recommend reading this manual thoroughly before operating the microscope cam-
era, and that it be kept on hand for future reference. If lost or forgotten, a new copy can be 
downloaded from our website using the included passcode from your packing list.

Please keep all packing materials, as they are required for any warranty service to guarantee 
safe shipment to and from our location, and the packing list includes your password to access 
this manual at any time.

If you have additional questions or need assistance, please do not hesitate to email us at:

info@amscope.com

Or give us a call during business hours (6AM-5PM Pacific Standard Time, GMT-8) at:

888-950-2000 

Copyright © 2017 United Scope Inc. DBA AmScope. All rights reserved.

Copyright Notice
This document, which is in draft form and subject to change without notice, is an unpublished work containing 
confidential, trade secret information that is proprietary to AmScope, and is protected by laws pertaining to such 
materials. This document, the information in this document and all rights thereto are the sole and exclusive prop-
erty of AmScope and are not to be copied, used or disclosed to anyone, in whole or in part, without the express 
written permission of AmScope. AmScope assumes no liability for any damages incurred, directly or indirectly, from 
any errors, omissions or discrepancies between the use of this microscope and the information contained in this 
document.
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Before Use

Safety Precautions

1. As the microscope camera is a precision instrument, always handle it with care, avoiding 
impact or abrupt movement during transporation. Do not shake the package.

2. Do not place the microscope camera in direct sunlight or in high heat. Keap it indoors in a 
dry and clean place with temperateures between 32-100 degrees F (0-40 degrees C), and in 
maximum relative humidity of 85%.

3. Avoid touching the lenses on the cmaera body and the reduction lenses so that oil and dirt 
from your fingerprints do not obstruct your view.

Additional details regarding maintenance and safety can be found on page 10.
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Parts

MU USB2.0 Camera

Adapter Sleeves
Reduction Lens 
(SKU: RU050)

Camera Body

USB Cable



8 MU Series (Windows)User’s Manual

Parts

MU USB3.0 Camera

Adapter Sleeves

Reduction Lens 
(SKU: RU050)

Camera Body

USB Port 
(3.0 is Blue, 2.0 is 
White)

USB Cable
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Parts

Definition of Parts

Adapters/Spacers
	 Metal cylindrical sleeves that adapt a larger size ocular tube down to 23.2mm for the camera to fit.

 

Camera Body
Square metallic housing that holds the camera sensor and circuit board, as well as has a port to con-
nect a USB cable.
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Parts
Definition of Parts (Continued) 

Reduction Lens/Adapter
A lens that both reduces the incoming magnification from the microscope to better fit the image to the 
sensor’s size in the camera, and adapts the C-mount connection down to a 23.2mm port size, common 
on AmScope microscope models.

 
 
 
 
 
 
 
 
Software CD
CD that includes a copy of the software and driver for the camera, which allows the Windows PC to both inter-
face with the camera, and allows the user to interact with the camera via the on screen controls. 
 
 
 
 
 
 
 
 
 
 
USB Port

A standardized port (universal serial bus) that accepts a USB cable, allowing a connection between the 
computer’s USB port and the camera’s USB port to facilitate communication between devices.
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Getting Started

Quick Start
1. Check the packing list on www.amscope.com or included in your package to ensure that you’re received all 
items that are to be included:

	 - 1 Camera Body (SKU on sticker) (USB2.0 or USB3.0)
	 - 1 Reduction Lens/Adapter
	 - 1 Camera Adapter (30mm to 23.2mm)
	 - 1 Camera Adapter (30.5mm to 23.2mm)
	 - 1 Software CD
	 - 1 USB Cable

2. The camera can be mounted and assembled in two different primary ways:

C-Mount: If you intend to attach the camera via C-mount to your microscope, you can take the camera body 
and thread it onto your male C-mount port (25.4mm outer diameter, threaded).  
 
Reduction Lens/Adapter: If you intend to attach via the reduction lens/adapter (23.2mm port size compatibil-
ity), please thread the reduction lens onto the camera body.

3. Insert the software CD into the CD tray of your computer. If your device does not have a CD drive, you can 
download the software from our website at www.amscope.com/software-download. For instructions on down-
loading the software and installing it, please see the following sections.

4. Install both the driver and the software by following the on screen instructions. For detailed instructions on 
installing the software and driver, please see the following sections depending on if installing from the CD or 
from a downloaded file from our website (pages 10 - 12).

5. Once the software and driver are installed, connect the included USB cable to the camera body’s USB port, 
and then the USB port on your computer.

6. Activate the software by double clicking the AmScope/ToupView shortcut icon on your desktop or Start 
Menu.

7. Once the software has loaded, on the left hand side, you should see the “Device List,” showing your camera. 
It may be either named the file name of the driver, or the SKU of your camera (MU300, for example). If you see 
the camera listed there, click the name to open up the live feed from the camera

8. Install the camera into your microscope, whether through a 23.2mm, 30mm, or 30.5mm eyepiece, or trin-
ocular port, or via C-mount. Open any shutter ports on your microscope if applicable, and turn the light on the 
microscope. You should see an image (although it may require refocusing) from the camera. 
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Getting Started
Installing the Software (CD)

1. Begin by placing the software CD in your computer’s CD tray, and insert the CD.

2. Windows should either bring up the AutoPlay function. When asked, select the first option “Run autorun.
exe” in order to access the AmScope/ToupView installation menu.

3. Next, click “Install Application” to start the Installation Wizard.
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Getting Started
Installing the Software (CD) (Continued)

4. Once the Installation Wizard has opened, please click “Next” to continue.
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Getting Started
Installing the Software (CD) (Continued)

5. The next window will let you choose where you wish to install the program to. If unsure, leave as default, 
and press “Install” to continue.

Pressing “Browse” will allow you to navigate to the folder you wish to install the software to using the File 
Browser, or, if known, you may type in the address to the Destination Folder directly.

When done, press “Install” to begin the installation process.
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Getting Started
Installing the Software (CD) (Continued)

6. The Installation Wizard will then begin installing the program onto your computer’s hard drive in the folder 
designated by you on the previous page. 

Please wait until the bar has been completely filled, upon which the Installation Wizard will automatically prog-
ress to the final Installation Wizard window.



16 MU Series (Windows)User’s Manual

Getting Started
Installing the Software (CD) (Continued)

7. The final page of the Installation Wizard will advise whether the software and driver package was success-
fully installed or not, and if so, will allow you to immediately open the software. 

By keeping the “Run AmScope 3.7” box ticked, upon hitting “Finish,” the software will open. 

If unticked, pressing “Finish” will simply close the Installation Wizard. 
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Getting Started

1. Begin by identifying which specific MU series camera model you have. This can be viewed on the SKU on the 
sticker of the camera body, and starts with “MU” followed by a series of numbers.
 
2. Open your web browser (Google Chrome, Internet Explorer/Edge, Mozilla, Safari, Opera, etc), and in the ad-
dress bar, type “www.amscope.com/software-download”, and press Enter.

Note: Alternatively, you may input “www.amscope.com” and navigate to the bottom of the page to find a 
section titled “Customer Support,” and click “Camera Software Downloads” to open the page.

3. Once on the Camera Software Downloads page, select the first drop down menu under “Select Camera” by 
clicking the arrow in the box, and from the menu that drops down, select your camera model (MU Series) by 
clicking on it.

Installing the Software (Download)
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Getting Started

4. To the right of the “Select Camera” drop down menu, there is a second drop down menu titled “Select Oper-
ating System.” Click the arrow to drop the menu down, and select “Windows”  by clicking on it.

Note: If you’d rather manually search for the software/driver, you can also simply scroll down the page until 
you find “MU Series” and select the version of the driver and software you’d like to download.

5. Once you’ve selected both camera series and operating system, a new section will appear just below the 
drop down menus, listing the various versions of the software we have available. Please select the most recent 
release (listed at the top of the list), and to the right, under “Download Link,” click “download,” and do the 
same for the DirectShow driver (or Twain, if your application requires it--DirectShow is best for most users).

Note: Both driver AND software must be installed for the camera to function.

Installing the Software (Download) (Continued)
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Getting Started

6. By clicking “download,” your web browser will automatically begin downloading the installer package to the 
location that is set as your Downloads folder.  Some web browsers will show the download on the bottom of 
the bar once completed, or will appear in a “Downloads List” funtion in your web browser’s menu. Once it is 
marked as complete, proceed to the next step. Below is an example using Google Chrome.

Note: Different web browsers have different default locations for your “Downloads” folder. We cannot be 
sure where your file goes if you have changed it, so, please be aware of where on your computer’s hard drive 
you have your Downloads folder set to, as that will be where the installer package is located once it finishes.

7. Locate the installer package where the web browser placed it. A quick way to locate it is to right click on the 
download in your browser’s download list or bottom bar, and click “Show in Folder” which will open a window 
of that folder’s contents. Below’s example is from Google Chrome, but, all web browsers have a variant of this 
function.

Installing the Software (Download) (Continued)
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Getting Started

9. The installer file is packaged in a .zip file, which is a compressed file format that allows you to send multiple 
files over the internet as a single file, and compresses them so that the file size is smaller, and thus, faster/easi-
er to transfer. Because of this, you cannot immediately open it like you would a program (a .exe file) or a folder. 

Think of a .zip file as a cardboard box or envelope with multiple things in it. You must first open the cardboard 
box with a knife, or the letter with a letter opener, in order to access the contents. 

Luckily, Windows 7 and higher editions have .zip extraction functionality built into them. Simply right click the 
.zip file, and select “Extract All.” 

Note: If you are using an older version of Windows, such as XP, you may have to download and install Win-
RAR, which is a freely available software. The below image is shown using WinRAR’s context menu options, 
which work with all Windows versions, however, the native Windows options are similarly named.

10. Follow the on screen instructions, hitting “Next” until it shows “Finish,” which after clicking, will show you 
your newly extracted files.

Installing the Software (Download) (Continued)
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Getting Started

11. Look for the installer file, which has a file extension (ending) of .exe, and a type of Application. Double click 
this in order to run the Installation Wizard.

12. When the Installation Wizard window opens up, please click “Next” to proceed. 

Installing the Software (Download) (Continued)
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Getting Started

13. The second page of the Installation Wizard lists the software license terms and conditions of use. Please 
read through them and click “I Agree” when complete to proceed. If you do not agree with the license terms, 
the software cannot be installed and used.

Installing the Software (Download) (Continued)
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Getting Started

14. Now, you will be given an option to select a location to install the software to. You can leave this at the 
default location if unsure or you do not have a preference, or, press “Browse” to select a folder to install the 
program to. Alternatively, you can type in the folder’s address in the Destination Folder bar.

When ready, click “Install” to proceed with installing the software.

 

Installing the Software (Download) (Continued)
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Getting Started

15. Once complete, the Installation Wizard will display a final confirmation window, and the “Next” button will 
change to a “Finish” button. The driver still must be installed before the camera will function, so untick the 
“Run AmScope” box, and click “Finish.”

16. Navigate back to the folder to which the driver download is located. We offer two drivers (DirectShow and 
Twain), however, DirectShow works with most applications for most users. The installation procedure is the 
same for both. Double click your desired driver installer to start the Installation Wizard. 

Installing the Software (Download) (Continued)
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Getting Started

17. When the Installation Wizard window opens up, please click “Next” to proceed.

Installing the Software (Download) (Continued)
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Getting Started

18. The second page of the Installation Wizard lists the software license terms and conditions of use. Please 
read through them and click “I Agree” when complete to proceed. If you do not agree with the license terms, 
the driver cannot be installed and used.

Installing the Software (Download) (Continued)
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Getting Started

19. Now, you will be given an option to select a location to install the driver to. You can leave this at the default 
location if unsure or you do not have a preference, or, press “Browse” to select a folder to install the program 
to. Alternatively, you can type in the folder’s address in the Destination Folder bar.

When ready, click “Install” to proceed with installing the DirectShow or Twain driver.

Installing the Software (Download) (Continued)
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Getting Started

20. The Installation Wizard will proceed to install the DirectShow or Twain driver. When it has completed, it will 
automatically move to the final page.

Installing the Software (Download) (Continued)
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Getting Started

21. Once complete, the Installation Wizard will display a final confirmation window, and the “Next” button will 
change to a “Finish” button.

22. You are now ready to open the software and use the camera. Please plug in the camera, and navigate to 
your desktop. You will now see either a yellow “A” or a yellow “T” (AmScope / ToupView) depending on what 
version of the software you chose to install. Double click either to open the software.

Installing the Software (Download) (Continued)
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Using the Software

Activating the Camera
1. Begin by opening the software. Double click your AmScope/ToupView shortcut icon (the yellow “A” or “T”) 
from the desktop, or single click the AmScope/ToupView shortcut icon from the start menu.

2. Once loaded, locate the “Device List” on the left hand navigation bar, and click the camera name to activate 
the live view from the camera. 

3. What the camera is currently seeing will appear in the gray area to the right of the navigation bar. While view-
ing the camera’s feed, adjust the focusing knobs on the microscope until the feed is in clear view of your desired 
sample.

4. From here, you can adjust the software settings as desired to fine tune the image manipulation options, cap-
ture a photo, or record video as desired. Instructions for taking a photo, video, calibration for measurement, and 
fine tuning image settings are covered in the following sections.
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Using the Software
Capturing & Saving a Still Image

Opening a Saved Still Image

1. To capture an image, once you are focused on the sample and it is in clear view in the software view, simply 
press the “Snap” button with the photo of the camera. Be sure to set the “Snap” resolution to the resolution 
desired of the still image recording prior to pressing “Snap.”

2. A new tab will open over the camera view area, noted by the different colored tabs at the top. The “Video 
[Camera SKU Here]” tab will always be the live view of what the camera is feeding the software. The following 
tab will be the number of photo taken--in this case, “0001*” meaning the first photo of this session.

3. To save the photo, click on “File” at the top navigation bar of the software, and “Save” (or “Save As”). “Save” 
will immediately save it in the desired directory in the default format, while “Save As” will allow you to select not 
only a directory and a name, but also the file type (such as .jpeg, .png, etc.). Select either method, name your 
photo, and select where you’d like it saved to.

1. To recall a previously saved photo, simply click “File” from the top navigation bar, and click “Open Image.” This 
will open a navigation window, allowing you to locate and select which photo you would like to open.

2. Once you have located and selected the file you wish to open, click it, and click “Open.” The image should ap-
pear as a tab in the view area with the file name as the name of the tab.
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Using the Software

Recording & Saving a Video
1. To record a video, once you are focused on the sample and it is in clear view in the software view, simply press 
the “Record” button with the photo of the “Play” button (the triangle pointing to the right). Be sure to set the 
“Snap” resolution to the resolution desired of the video recording prior to pressing “Record.”

2. The “Video File” window will pop up, asking you to name your video file, and select a location to save the re-
cording to. Select your desired location, and type in the desired name for your video, then press “Next.”
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Using the Software

Recording & Saving a Video
3. The “Video Format and Encoder” menu will appear next, asking which file format you would like to save and 
encode your video in. Most users will use .wmv or .avi. If unsure, use .wmv, and press “Next.” 
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Using the Software

Recording & Saving a Video (Continued)
4. The “Encoder” menu will appear next, asking what parameters you would like to use to encode your video, 
such as what bitrate you would like to use, the quality, and the key frame spacing. If unsure, leave these at de-
fault. 

“Bitrate (Mbps)” is the numbers of megabits per second that can be transmitted along a digital network. In this 
case, it is how many megabits per second the video will record to the file. A larger number will have more bits, 
and thus, a higher playback quality, however, will also have a much larger file size, and require greater processing 
power for both recording and playback.

“Quality” is a percentage in this case, and can be set anywhere between 0 and 100 to improve file size, ease of 
playback/transmittal. It is set to 100 by default, however, can be adjusted as needed.

“Key Frames Spacing” refers to the time between frames in which the encoder will re-evaluate the video image 
and record a full frame, rather than recording just the changes. Unlike traditional film, digital recordings often 
only record what has changed in an image in between frames, rather than capturing an entire frame each time, 
in an effort to speed up frame rates and minimize file sizes. Adjusting this higher will cause your encoder to 
speed up recording, however, will drop image quality if you have rapid motion in your sample. Lowering it will 
increase your quality at the expense of frame rate.

When done, please press “Next” to continue.
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Using the Software

Recording & Saving a Video (Continued)
5. The “Display Information” menu will appear next, allowing you to set the ID3 tags for your video. These are file 
properties that will show up in certain playback softwares, and is useful for cataloging results. While not neces-
sary, you may fill in this section. When completed, please press “Next” to continue.
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Using the Software

Recording & Saving a Video (Continued)
6. The “Start to Record” menu will appear next, allowing you to set how long you wish the video to record for (if 
you wish to set a limit), and the time-lapse (time between captured frames). These can be adjusted if desired, or 
left alone to have a normal, smooth video that will record until you hit the “Record” button again to stop. Press 
“Finish” when ready to begin recording your video.

Note: At any time from when the “Video File” window (step 2) is open, you can press “Finish” instead of “Next” 
to immediately begin recording, and leave all other settings as default. 

7. When you have finished recording, you can press the “Record” button again to stop the video, or simply wait 
for the time that was set in step 6 to elapse. The icon next to “Record” will change to a red circle with a gray 
square in it, much like the “Stop” button on most recording devices.
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Using the Software

Recording & Saving a Video (Continued)
8. The video recording is automatically saved to the folder designated on the “Video File” menu (step 2), so no 
further saving procedure is necessary.

9. If you wish to load a video for playback, you can navigate to the file folder containing the video and play it 
using your desired media playback software. We recommend Video Lan Controller (VLC), which is a free to use 
software available on the internet, and has a wide compatibility with different codecs and encoding methods. 

Note: We at AmScope are not affiliated with VLC in any way, shape, or form.
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Using the Software
Understanding the Software Options

Left Hand Navigation Bar (Camera Bar)

This section covers the various options and adjustments that the software is capable of. Understanding these 
software options is essential to successful operation of the software, and in getting the desired results. Every 
camera sensor is a little different, even from the same assembly line, and every environment and sample has 
differences, thus, the options here are designed to allow you the flexibility to compensate for those factors.
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Left Hand Navigation Bar (Camera Bar)
Camera List

Capture & Resolution

This section displays the connected device(s) to your system. Note that only one camera will be recognized at a 
time by the software, usually whichever is the most recently attached device.

Clicking a camera in this section will activate that camera in the viewing area to the right of the navigation bar.

This section houses the “Snap” and “Record” buttons, which allow you to snap a still image, or record a video. 
Additionally, this section contains the resolution adjustments available for the camera. 

“Live” resolution refers to the resolution that the camera’s live view is fed in.
“Snap” refers to the resolution that both still images and recorded videos are captured at.

Note: The lower the resolution selected, the faster the camera can respond, as there is less data being pro-
cessed per frame. This results in a faster frames per second (FPS) rate. You can lower the “Live” resolution 
while keeping the “Snap” resolution up to focus/adjust the microscope more easily, while not sacrificing reso-
lution for your still images. Unlike still images, video recorded frame rates will be affected by the “Snap” resolu-
tion as well, causing an FPS drop the higher the resolution is.
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Left Hand Navigation Bar (Camera Bar)
Exposure & Gain

This section contains various settings regarding exposure, which is how much light the camera sensor accepts 
per frame, and gain, which is a brightness setting controlling how dark “black” colors appear.

By default, the “Auto Exposure” box is ticked, meaning the camera itself will automatically adjust these set-
tings to compensate for different amounts of light coming from the microscope’s light source. The drawback of 
the Auto Exposure feature is that it can cost a few frames per second as the camera is constantly adjusting the 
exposure target and time, requiring additional processing time. Turning this off and manually setting the sliders 
is recommended if you need faster frame rates from the camera, or the image does not appear at the desired 
brightness level even after adjusting the “Exposure Target.”
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Left Hand Navigation Bar (Camera Bar)
White Balance

This section allows for adjustments in “Color Temperature” and “Tint” in order to ensure that the camera sen-
sor is capturing the correct colors. Often times, cameras can come out of the box seeing different colors differ-
ently, and thus displaying them as such. 

Pressing the “White Balance” button at the bottom of this section will automatically make adjustments to 
Color Temperature and Tint to balance out at a point where items that are known to be white appear as white, 
and all other colors are adjusted based on that known point in the color spectrum.

When clicking the button, an adjustable red box will appear in the viewing area. If your sample has an area that 
is supposed to be white (blank space between the sample’s elements, or a sheet of thin white paper if calibrat-
ing without a sample), drag and resize the box so that everything inside the box is supposed to be white. Press 
the “White Balance” button again, and your sample will be adjusted properly for correct white balance. The 
sliders can be used to further adjust as necessary.

“Defaults” will return it to factory settings so you may readjust and start the process over.

“Color Temperature” adjusts colors between cyan on the low end (cooler color temperatures) and yellow on 
the high end (higher color temperatures).

“Tint” adjusts colors between magenta on the low end and green on the high end.

Usually, the automatic “White Balance” button, when used as above, sets this very accurately without use of 
the sliders.
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Left Hand Navigation Bar (Camera Bar)
Color Adjustment

Much like the section before it, this section allows you greater control over the colors as they appear in your 
image through various sliders. 
 
The “Hue” adjustment allows you to shift the colors displayed between the entire visible color spectrum. Ad-
just as needed if your colors are entirely shifted the wrong way.

The “Saturation” adjustment slider allows you to adjust how powerful your colors appear in your image, affect-
ing their vibrancy. A higher value on the slider will have more vibrant and powerful colors, while a lower value 
will be toned down or grayed out.

The “Brightness” adjustment slider defines how intense the “white” colors in your image are. A higher value 
will appear more brightly lit (or washed out if too bright), while a lower value will dim your image’s white col-
ors down for a darker overall image.

The “Contrast” slider adjusts how strong the difference is between light and dark pixels that neighbor each 
other. A higher value will add more contrast between them, better defining but also darkening your image, 
while a lower value will brighten up the image, but also create less definition between elements in your sam-
ple.

The “Gamma” slider serves as an adjustment in how the sensor processes light captured from the sensor. A 
higher value will darken the image, while a lower value will brighten the image.
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Left Hand Navigation Bar (Camera Bar)
Power Frequency (Anti-Flicker)

This section is only available by turning “Auto Exposure” off in the “Exposure & Gain” section. It allows you to 
set the CMOS sensor to capture frames in alignment with the frequency of local power supply powering the 
microscope. CMOS sensors use a rolling shutter (captures each row of pixels from top to bottom sequentially), 
so if the light is not flickering at the same rate as capture, a flickering effect or rolling lines will be seen.

If you are detecting a series of rolling lines or flickering when viewing your sample, the “Anti-Flicker” system 
may help resolve the issue. Turn “Auto Exposure” off and select the power frequency of nearby devices to the 
camera (such as the microscope, computer, monitor, etc).

Frame Rate
This section covers manual adjustment of the camera’s frame rate (FPS). By default, it is set to the max speed 
possible, as users are looking for the closest to live experience possible from cameras. If your application 
deems it necessary, you can lower the frame rate as desired here.

Note: Although this section exists, the greatest effect on frame rate will come from the resolution seelcted, 
whether the device in use is a USB2.0/3.0 device (in a compliant USB2.0/3.0 USB port), and the Exposure & 
Gain settings (as well as the Sampling section, covered below).
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Left Hand Navigation Bar (Camera Bar)
Color/Grey

This section allows you to switch the camera sensor between “Color” mode and “Gray” mode. Color captures 
images in color, while Gray captures images in grayscale (black and white).

Flip

Sampling

This section allows you to flip the image received from the camera along either the “Horizontal” or “Vertical” 
axes. Horizontal will flip the image from left to right, while vertical will flip the image from top to bottom.

The “Sampling” section contains two options: “Bin” and “Skip.” 

“Bin” option refers to the method of averaging pixels in blocks of neighboring same color pixels to resize the 
video to a lower resolution. It provides a small speed increase while maintaining image integrity.

“Skip” (also “Decimation”) skips a pre-determined amount of pixels (either horizontally, vertically, or in both 
axes) to reduce the resolution of the resulting video, increasing speed. This method introduces subsampling 
artifacts, however. Skip is on by default.
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Left Hand Navigation Bar (Camera Bar)
Bit Depth

ROI (Region of Interest)

Histogram

Bit depth refers to the color information stored in an image. The higher the bit depth, the more colors it can 
store. 1 bit stores 2 values, so a 16 bit image can store 32 different color values.

This section allows you to select a specific area in your sample’s view area as the region that one is interested 
in viewing. It is simply a visual aid for the user.

This section is a graph that illustrates how pixels in an image are distributed by graphing the number of pixels 
at each color intensity level, including shadows (low values), mid-tones (middle of the range), and highlights 
(top of the range). This is mainly used to ensure that the image captured has enough detail to use other correc-
tions effectively.

The drop down menu (by default set to “RGB”) allows you to view all or a single color channel.

“Left” and “Right” allow you to set boundaries to limit the range for best image quality. Clicking “Auto” will 
automatically set these boundaries for the software’s detected ideal range.
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Left Hand Navigation Bar (Camera Bar)
Dark Field Correction

Cooling

Darkfield images are a specialized type of microscopy used to create additional contrast in a sample  by using a 
dark background instead of a light background, as well as lighting the sample from oblique angles (lighting the 
edges of the sample by angled lighting). Because of the nature of darkfield, normal image capturing methods 
with cameras are not ideal.

This section allows one to correct the image digitally for a superior final result.

First, cover the objective lens of your microscope to ensure the field is totally black. You may also simply close 
the shutter on your microscope’s trinocular port if it has one.

Next, hit the “Capture” button. This will capture a black image, enabling the dark field correction function.

Simply hit “Enable” and focus on your darkfield sample for best results, and use the software as normal. Hitting 
“Enable” again will turn correction off.

The MU series cameras do not have a cooling mechanism in their design, however, this section is used to con-
trol the cooling functionality of other cameras that use this software.
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Left Hand Navigation Bar (Camera Bar)
Misc

Parameters

This section only contains a single function, “Negative,” which inverts the colors in the image.

This section allows you to save all of the above options as a configuration file, which can be later recalled to 
avoid having to set them each time. 

The “Save” button allows you to save a series of settings, which can then be recalled using the “Load” button. 
Clicking “Save” allows you to name the settings, and adds it to the drop down menu. Select it from the drop 
down menu, and hit “Load” to import them.

“Overwrite” will save your current settings onto an existing saved parameter group.

“Management” will let you sort, delete, or copy your saved parameters.
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Top Toolbar

File Shortcuts

Measurement Swap Shortcuts

This section is located above the left navigation bar and viewing area, and contains shortcuts to many tools the 
software has to further enhance your image, create annotations, or simple quality of life improvements. Each 
one will be covered in the following sections.

The first four icons on the toolbar (from left to right):

Open Image - Open a single image file.
Save - Save the currently open image file.
Quick Save - Saves the currently open image file with a default name.
Browse - Changes the left navigation bar from the “Camera Bar” to the “Folder Bar,” providing quick access to 
open files on your hard drive in the viewing area.

Note: To change back to the “Camera Bar,” click the tab below the left hand navigation bar titled “Camera,” 
and click the first tab in your viewing area to return to the camera’s live view.

The following two drop down menus are useful when you have calibrated your software to capture measure-
ments in real distance while looking at a sample through your MU series camera. If you have not yet per-
formed the calibration procedures using a micrometer slide or other unit of known measurement, these func-
tions will not actually change anything.

From left to right, the options are:

Measurement - Allows you to quickly swap between measurement sizes, such as milimeters (mm) and nano-
meters (nm).

Magnification - Allows you to quickly change between calibrations performed at different magnifications.

These are important because the camera itself only sees an image in pixels. By telling it how many pixels are in 
a given unit of measurement at a specific magnification level, the camera software can perform measurements 
in real distance by extrapolating how many pixels are in the requested line or arc, and converting it to real 
measurement. Without calibrating the software, it will always read and feed back in pixels, as that is the only 
thing the camera sensor and software can actually quantify. For more details on calibration, please see “Cali-
brating the Software” on page 140.
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Top Toolbar
Selection & Movement Tools

Drawing and Annotation Tools

The following two tools are used to select or highlight an area in an image or video, and if zoomed in, to move 
the zoomed in area around to scan.

From left to right:

Select - Allows you to highlight an area of interest in the viewing area. Similar to the ROI function.
Track - Allows you to grab and move the image, if the image is zoomed in more than the screen display area.

The following tool set is used for drawing measurements, lines, arcs, and annotating the captured images.

From left to right:

Object Selection - Enables the mouse cursor to select a previously drawn object.

Angle - Creates either a three or four point angle and provides the measurement data of the angle drawn.

Point - Creates a point and provides X and Y coordinates in the selected measurement size.

Line - Creates one line and provides X and Y coordinates of each end, as well as the distance between points.

Parallel - Creates two lines, locking the angle of the second to the angle of the first, and providing measure-
ment information of length, angle, start, end, and distance between lines.

Two Parallel - Creates two pairs of parallel lines with a midpoint line, and provides above measurements.

Vertical - Creates a line and a second line perpendicular to it, and provides above measurements.

Rectangle - Draws a rectangle and provides perimeter, width, height, and area.

Ellipse - Draws a circle with dissimilar axes, providing length of each, perimeter, area, and center point.

Circle - Draws a circle with similar axes, with either a diameter, radius, or triple point methods.

Annulus - Draws multiple concentric circles with a common center point.

Two Circles - Draws two circles sequentially, and provides distance between center points.

Arc - Creates an arc after setting the first point, providing center point, diameter, perimeter, and angle.

Text - Creates a text box for putting notes on the image for items of interest.

Polygon - Draws a polygon of the user’s choice number of points, and provides area and perimeter. Right click 
to close the polygon, left click to add a point.
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Top Toolbar
Calibration Shortcuts

Image Enhancement Tools

The following two tools are used as shortcuts to access calibration menus.

From left to right:

Calibration - Opens the Calibration menu, allowing you to use a unit of known measurement and a given mag-
nification to provide the software with the means to extrapolate real distances from pixels counted on screen.

Grey Calibration - Provides the average gray value in the image per frame displayed.

The following three tools are special tools used to improve the image as captured on screen in various man-
ners using software manipulation.

From left to right:

Stitch - The Stitch tool allows users to take images taken at different points along the X and Y axes, and put 
them together into a single image. It is particularly useful when the field of view is not large enough to capture 
the entire region of interest in a single photo, allowing the images to be stitched together in a linear or grid 
format.

Extended Depth of Focus (EDF) - The EDF tool allows users to take a sequential series of photos from different 
focal points, and have the software digitally mesh them together, creating a more deeply focused image. This 
is useful when you need high magnification values, but, cannot get a large enough depth of field to have the 
whole area in focus at one time due to contrasting sample topographies.

High Dynamic Range (HDR) - The HDR tool allows users to capture images with a larger range between how 
dark and how bright an image can be in terms of contrast.
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Top Navigation Bar

File Menu

Above the tool bar is the top navigation bar, which begins with the “File” drop down menu, and ends with the 
“Help” drop down menu. These menus contain the full range of tools and options that the software is capable 
of, although since there are many shortcuts on the tool bar and the left hand navigation bar for commonly 
used procedures, using the menus is generally only as a last resort if a feature you need is not available via a 
tool or shortcut.

The following functions are available in the “File” drop down menu:

From top to bottom:

Open Image - Selecting “Open Image” will bring up the file navigator, allowing you to select a previously saved 
photograph to open in a new tab in the viewing area. Control + O is the keyboard shortcut for this function.

Open Video - Seleting “Open Video” will bring up the file navigator, allowing you to select a previously saved 
video to open in a new tab in the viewing area.
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Top Navigation Bar
File Menu (Continued)

Open Broadcast - Seleting “Open Broadcast” will bring up the Open Broadcast menu, allowing users to input 
an IP address and port to receive video from. Performance is bandwidth dependent.

Save - Selecting “Save” will immediately save a copy of the image tab currently open to the default folder, , 
while still leaving the image tab active. If the file has not been saved before, it will default to the “Save As...” 
function, and require a name to be input, and a file type selected. Control + S is the keyboard shortcut for this 
option.

Save As... - “Save As” will, regardless whether the image has been saved before or not, open a dialog menu 
requiring file name and file type selection, and allows you to save the file.

Batch Save - This menu option allows the user to save multiple captured images at once, using a designated 
file prefix, name, and file type, and automatically appending a numerical value to the image.

Quick Save - “Quick Save” saves the currently opened image tab without requiring name or format input. It will 
default to the values set in the “Options -> Preferences” menu. Control + Q is the keyboard shortcut for this 
option.

Paste as New File - If an image file is copied onto the clipboard in Windows, this function will allow the user to 
paste that image into a new image tab.

Twain: Select Device - AmScope/ToupView software supports other Twain compatible image capture devices. 
Unfortunately, we at AmScope do not support other devices on our software, nor do we support third party 
softwares for our camera devices. This menu option is used to select a Twain compatible source to use within 
the software. All AmScope/ToupTek cameras are part of the AmCam/Toupcam Twain source.

Twain: Acquire - Allows the user to acquire an image from a Twain compatible device. Please see above.

Print Setup - Activating “Print Setup” brings up a menu to allow the user to select which printer, and what 
printing options, they would like to use to print the currently active image prior to printing.

Print Preview - “Print Preview” shows the user a preview of what to expect to come from their selected printer 
if the image in the active tab is printed (size and orientation particularly). Control + Shift + P is the keyboard 
shortcut for this function.

Print - Allows the user to print the currently active tab with their default printer and printing options. Control + 
P is the keyboard shortcut for this option.

Recent Files - Contains a list of recently saved and opened files for ease of access.

Exit - Closes the AmScope/ToupView software.
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Top Navigation Bar
Edit Menu

The “Edit” menu contains options for manipulating items on the clipboard, and the current active window.

Cut - This menu option allows the user to remove a selection from the image attached and place it on the clip-
board to be placed somewhere else. Control + X is the keyboard shortcut for this function.

Copy - “Copy” performs the same action as “Cut,” however, instead of removing the selected area from an im-
age, it creates a copy, leaving the original selection as a part of the image. Control + X is the keyboard shortcut 
for this function.

Paste - If an image file is copied onto the clipboard in Windows, this function will allow the user to paste that 
image or selection onto the currently active image. Control + V is the keyboard shortcut for this function.

Paste Shortcut - If an image file is copied onto the clipboard in Windows, this function will allow the user to 
paste that image or selection onto the currently active image. 

Delete - The “Delete” function allows a user to delete the current selection from the image. The “Delete” key is 
the shortcut for this function (not the “Backspace” key).

Image Select - This tool will allow you to select an area of interest in the currently active image tab in the view-
ing area, and use that for the above functions.

Select All - This tool selects the entire image in the currently active tab in the viewing area. Control + A is the 
keyboard shortcut for this function.

Select None - Removes any selections in the viewing area in the currently active tab. Control + D is the key-
board shortcut for this. Also known as “Deselect.”
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Top Navigation Bar
View Menu

The “View” menu contains options for manipulating the current active view, navigation bars, and opened tabs.

Browse - This menu option opens the file explorer box, allowing you to navigate and select an image or video 
to open from your hard drive. Control + B is the keyboard shortcut for this function.

Measurement Sheet - This option brings up the “Measurement Sheet” from the bottom of the software win-
dow, which allows you to see a table of measurements that have been performed. This can also be accessed by 
clicking “Measurement Sheet” at the bottom of the screen.

Sidebar - This menu folds out into another menu, which allows the user to turn different tabs of the left hand 
navigation bar on/off as desired. The potential side bars are Camera, Folders (Quick Browse), Undo/Redo, Lay-
ers, and Measurements. One can change between these tabs at the bottom of the left hand navigation bar as 
well.

Grids - This function allows the user to create custom sized grids superimposed over the currently active im-
age. It folds out into a new menu, allowing the software to draw the grid automatically with “Auto,” the user to 
draw their own with “Manual,” or the “Settings” window for more detailed customization.

Best Fit - This tool will zoom the displayed image to fit the viewing area best in either the vertical or horizontal 
dimention. Note: This is NOT increasing your magnification, just enlarging the currently displayed image.

Actual Size - This function adjusts the size of the image or camera feed in the viewing area to fit the actual size 
it is capturing and displaying at (the “Live” resolution or “Snap” resolution if looking at a previously captured 
image).

Full Screen - This tool enlarges the image in the viewing area to fit the entire screen. The “Escape” key can be 
used to return to the software view.
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Top Navigation Bar
View Menu (Continued)

Track - When zoomed in to the image to the point where the image is larger than the display area (or using a 
high resolution setting to view from the camera), the “Track” or “Hand” tool is used to slide the image to scan 
different areas. It is only usable when zoomed in. If the image is entirely fitted to the viewing area, it will not 
move the image.
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Top Navigation Bar
Browse Menu

The “Browse” menu is disabled unless a file browsing tab is open in the viewing area. This can be done by click-
ing the “Folders” tab in the bottom section of the left navigation bar, then clicking the “Browse” button.

Sort - The “Sort” function allows the user to sort how the files or folders are displayed in terms of order, by 
various categories (file type, name, size, etc). This allows you to more easily find the files you are looking for.

Icons - The “Icons” function allows the  user to change the properties of the displayed icons for the folders and 
files in the “Browse” tab to either be large or small icons.

Refresh - “Refresh” is a command that tells the “Browse” tab to recheck the folder to see if any changes have 
been made, and display the latest version of that folder. This is useful if a file was saved or modified after open-
ing the “Browse” tab, but is not displayed.

Properties - This tool brings up the associated properties with the file or folder currently selected in the 
“Browse” tab.
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Top Navigation Bar
Setup Menu

The “Setup” menu is used primarily to adjust settings related to producing video, such as watermarks, file 
properties, and overlays.

Start/Pause - The “Start/Pause” command allows the user to freeze the image provided from the camera or 
the video being viewed in place. Using the command again will unpause playback.

View Properties - This function brings up the “View Properties” menu, which will display detailed information 
about the device being used, such as device name, pixel size, and resolution.

Video Overlay - The “Video Overlay” function brings up a menu that allows the user to customize a digital 
overlay or marker on their recording. Adjustments range from position and size, to color and type, such as 
scale, date/time, clarity factor, etc for overlays, and circles or crosses (or a combination) for markers.

Video Watermark - The “Video Watermark” function brings up the Watermark menu, allowing the user to 
select an image to place on their video (with opacity controls to allow it to be seen in front of the video) to 
protect against unauthorized reproduction or redistribution of the video, if captured video/images are propri-
etary intellectual property. Watermarks are hard encoded onto the video, preventing easy removal.

Move Watermark- The “Move Watermark” function allows the user to reposition the watermark. Common 
places are spanning the entire image but more translucent than most, or in any of the four corners of the im-
age, with more opacity.

Rotate Watermark - “Rotate Watermark” will allow the user to pivot the watermark among different angles to 
best fit their preferences.

Gray Calibration - This tool brings up the “Gray Calibration” menu, feeding the user a value of gray in the im-
age used to calibrate their device for gray reproduction accuracy.
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Top Navigation Bar
Capture Menu

The “Capture” menu encompasses tools that are used to take a photo, record a video, or start a broadcast.

Capture Image - This function captures a still image, much like the “Snap” button. F8 is the keyboard shortcut 
for this function.

Start Time-lapse (Auto Capture)... - This function opens up the “Time-lapse” menu, which allows you to desig-
nate the software to capture a still image at given intervals of time, up to a given length of time.

Start Record... - The “Start Record...” command is much like the “Record” button, which opens the “Record 
Video” menus, and allows you to begin or stop recording (depending on whether you are currently recording a 
video or not).

Start Broadcast - The “Start Broadcast” function opens the Broadcast menu, which allows you to designate an 
a port and the encoding settings for a live video to be broadcast over an intranet or the internet.
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Top Navigation Bar
Image Menu

The “Image” menu allows you to process the user’s current active image much like the selection modification 
in the “Edit” menu, with tools such as rotation, adjustment levels, cropping, scaling, and more.

Mode - This menu option encompasses three camera mode options: “Color Quantize,” “Grey Scale,” and “Con-
trast Preserving Decoloratization.” While sounding complex, they are rather simple. “CQ” allows you to select 
image bit values (most commonly used is 8 bit or 24 bit), “Grey Scale” allows you to convert the image from 
color to grey, and “CPD” does the same as grey scale, while preserving contrast for additional detail.

Adjust - Much like Photoshop, the “Adjust” section encompasses a number of potential adjustments to your 
image, ranging from brightness/contrast to enhancing details, refining edges, and color replacement.

Rotate - The “Rotate” section allows the user to turn the image angularly in preset degrees, or arbitrarily with 
an input value.

Crop - The “Crop” tool is used to remove excess sections from the image outside of the region of interest. Shift 
+ C is the keyboard shortcut for the “Crop” tool.

Scale - The “Scale” function is used with a captured image to enlarge or reduce the digital resolution of the im-
age while resampling the image. This does not add more detail (optical resolution), just more/less pixels.

Histogram - The “Histogram” tool allows the user to view the different color and light channels for a previously 
captured image. Useful in attempting to recreate a comparison image to another sample.

Resolution - The “Resolution” function opens the like named menu which allows a user to set a type of mea-
surement per pixel, much like calibrating, but for a property of the image, instead of a recallable measurement 
at a given magnification. Tells another user when transferring the file what measurement scale was used.

Mosaic - The “Mosaic” function is similar to the “Stitch” function, however, is used to process any open images 
into a single image--usually used to create side by side comparison images.
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Top Navigation Bar
Process Menu

The “Process” menu contains a plethora of useful tools to create more deeply focused, larger viewable area, 
and better annotated images using digital enhancement procedures built right into the software.

Stitch... - The Stitch tool allows users to take images taken at different points along the X and Y axes, and put 
them together into a single image. It is particularly useful when the field of view is not large enough to capture 
the entire region of interest in a single photo, allowing the images to be stitched together in a linear or grid 
format. Shift+T is the keyboard shortcut for this function.

High Dynamic Range (HDR)... - The HDR tool allows users to capture multiple images at varying degrees of  
with a larger range between how dark and how bright an image can be in terms of contrast, creating a more 
deeply contrasted image.

Extended Depth of Focus (EDF) - The EDF tool allows users to take a sequential series of photos from different 
focal points, and have the software digitally mesh them together, creating a more deeply focused image. This 
is useful when you need high magnification values, but, cannot get a large enough depth of field to have the 
whole area in focus at one time due to contrasting sample topographies. Shift+F is the keyboard shortcut for 
this tool. Note: This function is further explained in the “EDF” section of this manual. 

Deinterlace - The “Deinterlace” function allows a user to take an interlaced image (one which is processed in a 
series of rows, displaying a partial or blurred image until all rows have been processed) into a deinterlaced im-
age (one which displays at the same time.)
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Top Navigation Bar
Process Menu (Continued)

Color Composite - The “Color Composite” tool allows the user to select various color channels, and separate 
them into independently controlled elements. This allows a user to isolate specific colors of interest and elimi-
nate others--particularly useful in fluorescent microscopy. This tool is very detailed, and will be covered later in 
the “Color Composite” section of this manual.

Segmentation & Count - The “Segmentation & Count” function allows the user to use various histograms and 
methods to create segments of what one is interested in within an image, and exclude the rest, or to perform a 
count of objects of interest within the field of view.

Denoise - The “Denoise” function allows the user to use several methods to remove noise from the image, cre-
ating a cleaner and crisper image. This tool is covered in the “Denoise” section of this manual in greater detail.

Sharpen - The “Sharpen” tool is a function that allows the user to command the software to create a sharper 
image than the original capture by combining an unsharp positive image mask with the image’s negative, 
ultimately providing a better image than before. This tool is covered in depth in the “Sharpen” section of the 
manual.

Color Toning - The “Color Toning” function encompasses a number of tools used to calibrate the image based 
on the color representation of the monitor the image is being viewed with, as well as calibrating manipulation 
of the histogram for optimal results. “Color Toning” will be covered in depth in a later section.

Filter - The “Filter” function contains a number of tools used to enhance the image based on a number of dif-
ferent scenarios, such as using a high pass filter to enhance high-frequency information by adjusting contrast-
ing pixels within a certain frequency. The filters here are complex but very powerful, and are covered in detail 
in the “Filters” section of the manual.

Image Stacking- The “Image Stacking” function is used to take the average of multiple photos taken at the 
same point of reference, creating stronger photos with a greater signal to noise ratio (especially in low light mi-
croscopy such as fluorescent and darkfield microscopy). “Image Stacking” will be covered in depth in its future 
section.

Line Profile - The “Line Profile” function is used to create a graph illustrating the distribution of pixels along a 
line by color intensity. 

Surface Plot - The “Surface Plot” function works similarly to the “Line Profile” tool, however, instead of creat-
ing a graph, it creates a 3D representation of the sample based on color intensity and color position of each 
pixel. “Surface Plot” will be covered in more detail in its own section.

Pseudo Color - When a color is in grey scale, the “Pseudo Color” command can be used to color the image, 
useful in highlighting only specific details, or for temperature overlays.
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Top Navigation Bar
Process Menu (Continued)

Range - The “Range” function allows the user to set a high and low limit for color intensity, allowing one to 
increase contrast, specifically in low light situations. The “Range” function will be covered in a later section.

Binary - The “Binary” function sets a limit to the intensity of the grey pixel color, to where if the intensity is 
higher than the threshold, it is turned to white. This function is a key step in many other processes for ideal 
results, and will be covered in more detail in its own section.
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Top Navigation Bar
Layer Menu

The “Layer” menu is used to create and manipulate various different levels within the image. Each layer can 
contain image data, measurement data, or other annotations, allowing a user to non-destructively create these 
notes on an image, and edit or delete one, without having to start over again, or take a new image if a change 
needs to be made. There is also a “Layers” sidebar that can be used for easier navigation.

New... - The “New...” function creates a new layer in the current active image.

Remove... - The “Remove...” command eliminates the currently active layer.

Current... - The “Current...” command sets the selected layer as the active layer.

Show/Hide... - The “Show/Hide...” command will either display or not display the currently active layer as a 
toggle.

Rename... - The “Rename” command allows you to change the name of the layer for organizing data on mul-
tiple layers easier.

Export to Image - The “Export to Image” command exports the currently active image with all layers to an im-
age file.

Export to Microsoft Excel - The “Export to Image” command exports the currently active image with all layers 
to an Excel spreadsheet.
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Top Navigation Bar
Measurement Menu

The “Measurement” menu contains the same tools as the top toolbar for drawing and measuring, with a few 
new features not found there, such as the “Scale Bar...” and “Z Order” features.

The majority of the tools are covered in the top tool bar section, so in this section, we will only cover the “Ob-
ject Select,” “Scale Bar...,” and the “Z Order” functions.

Object Select - The “Object Select” tool allows the user to select a specific drawn or measured element in an 
image for viewing or manipulating with other tools.

Scale Bar... - The “Scale Bar” function allows the user to designate a scale bar to be placed on an image, allow-
ing quick reference of size when viewing a measured sample.

Z Order... - The “Z Order...” function allows a user to move a drawn measurement up or down in the “Z” dimen-
sion, which would be considered the layering order if the image was laid flat on a table, and the measurements 
were laid on top of it. A line can be placed on top of a circle, for example, to superimpose the image above the 
circle, or moved behind it.
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The “Options” menu contains menus used to alter the way that the program behaves from the default settings, 
calibrate for measurement in real distances (instead of pixels), and other functions that have their own set of 
alterable options.

Preferences - The “Preferences” menu brings up a menu containing settings that can be adjusted based on the 
core use of the software, such as default file locations, and languages. The keyboard shortcut for this menu is 
Shift+P.

Measurements...  - The “Measurements...” option opens the settings menu for measurements, allowing you to 
change parameters and behaviors of measurement tools.

Magnification... - The “Magnification...” function allows you to edit magnification options inputted during the 
Calibration process, changing the list order, or importing previously exported settings.

Calibrate - The “Calibrate...” function brings up the Calibrate menu, which allows a user to create various cali-
brations for the software to translate pixels into real distance measurements at a given magnification value.

Edit Dye List... - The “Edit Dye List...” function allows a user to create custom fluorescent dye parameters in the 
software, including extraction and emission wavelengths and dye names, useful when annotating fluorescent 
images.

Auto Correction... - The “Auto Correction” menu brings up the “Auto Range” settings menu, which allows you 
to adjust how aggressively the limits on the image are when using auto correction functions, such as “Auto 
Level” and “Auto Contrast.”
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The “Window” menu contains a few convenient but not often used features related to the viewing area’s tabs.

Close All - The “Close All” function closes all open tabs simultaneously, preventing the user from having to 
close them individually.

Reset Window Layout - The “Reset Window Layout” function will return the viewing area to it’s default set-
tings upon a restart of the AmScope/ToupView software.

Windows... - The “Windows...” function opens a menu allowing you to adjust or select an active tab as the 
main window, as well as saving a configuration of windows.
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The “Help” menu contains the software’s manual as provided by the developer, as well as the “About” option.

Help Contents - This menu options brings up this manual as a .pdf file within the software for review.

About... - The “About...” function displays the current software version being used and developer information.
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The “Stitch” tool is used when the user needs a larger field of view in a single image than the field of view the 
camera and microscope are capable of. This is done by “stitching” multiple captured images together at the 
edges, creating a single, larger image. This could be in a line or in a grid, depending on how many photos the 
user needs to capture, and how large of a field of view you ultimately need.

1. Begin by opening up the “Stitch” tool, which can be found under the “Process” menu, or opened with the 
keyboard shortcut “Shift+T.”

2. The new window that opens is the “Stitch” menu, which allows the user to capture an image, then move 
to the next area they’d like to capture, up to as many photos as needed to create the grid or line to cover the 
area needed. The “Snap” button will snap a shot of the area currently in view, and display it. You may use this 
in conjunction with the preview in the viewing area to line up the next snapshot to whichever direction you’d 
prefer. 

Continue until you have taken enough snapshots to cover the desired area of interest (in a grid or line). For 
best results, try to slightly overlap the image edges in whichever direction you are moving (horizontally or ver-
tically). Press “Next” when ready to continue.
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3. The following menu allows you to designate a variety of settings to determine how the “Stitch” tool will be-
have with the images you have taken.

Panorama Straighten - This setting tells the “Stitch” tool which direction you are stitching in, either Horizontal, 
Vertical, or None. Choose None if performing a grid type operation, or choose the direction you are moving in. 
Sometimes it is easier to do multiple stitches if needing a large grid, by doing a horizontal line at a time, then 
stitching each element of a line together, then stitching all lines together.

Projection Type - The “Projection Type” setting may seem confusing at first, but, it is both useful and simple. 
The “Projection Type” is a setting that will adjust the stitched image pattern to appear as if taken with a par-
ticular type of a lens, by projecting the image over a specified image “map.” Options such as cylindrical, spheri-
cal, fisheye, stereographic, plane, mercator, or transverse mercator can be selected here, while cylindrical is 
default. 

Seam Finder - The “Seam Finder” option allows you to set what method the “Stitch” tool uses to find seams to 
stitch the images together at. There are several options here as well, such as  Voronai diagram, graph cut color, 
grapch cut color grad, and none. Graph cut color is the default option, and works for most samples.

Exposure Compensation - The “Exposure Compensation” option is used to determine how the “Stitch” tool 
will handle differences in exposure between the various images to be stitched together. Options here include 
gain, blocks gain, or none. Default setting is blocks gain.
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Bundle Adjust - The “Bundle Adjust” option is used to determine how the “Stitch” tool will compensate for 
nodal differences when capturing three dimensional images. Ray adjust and reprojection error are the avail-
able options, with ray adjust as the default.

When done, hit “Next” to continue to the next menu, or “Finish” if you want to immediately begin the stitching 
procedure.

4. This menu contains sliders to adjust parameters of the previously selected settings.

Match Confidence - This slider adjusts the threshold used for creating seams and matching components 
between images to be stitched. The higher, the more precise, however, the more likely a failure to stitch error 
will occur, as this also requires greater precision when taking overlapping images. 65 is the default, and is the 
sweet spot between precision and leeway to create an image at all.

Panorama Confidence - This slider adjusts the threshold match required to determine which direction to stitch 
the images together at. It is set to 100 by default since direction is defined in the previous menu, and recom-
mended to leave at 100.

Match Strength - The “Match Strength” slider determines how strict the requirement of pixel color and inten-
sity must be before the software considers it a match. Moving it higher will result in more accurate stitching, 
provided the user takes photos with greater overlap in the same lighting conditions, otherwise it will fail.

Blend Strength - The “Blend Strength” slider determines how much blending is used when aligning and stitch-
ing images together. Raising this may cause blur, while lowering it may cause rough edges between stitches.
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When you have finished adjusting these settings, click “Finish” to have the software engage the “Stitching” 
process and put the images together.

5. The software will then attempt to stitch together the images taken based on the settings provided. Note that 
if it fails to stitch, you may have to retake the photos, and/or lower the strictness of your settings to allow a 
greater margin of error to get a successful stitch.
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“High Dynamic Range” is a post processing function that can fuse a sequence of multi-exposure images into a 
single image with a larger dynamic range (higher range between maximum and minimum contrast levels). The 
process requires the user to capture multiple images of the same point in their sample with different levels of 
exposure or different apertures on the microscope’s iris diaphragm for this to work.

The HDR function can be used either in the browse window or the image viewing area window, provided the 
images are selected if in the browse window, or are open in the image viewing area. Both methods will provide 
the same result.

1. Much like the “Stitch” function, if you select the menu with photos captured in the viewing area, you will be 
taken to a menu where you can add images to a list of images for the function to use. Add any desired images 
taken at the same position with multiple types of exposure.

Note: Unless multiple images are captured or selected in the browse mode, the HDR function will be grayed 
out. If unable to access the function, as shown above, please capture at least 2 images in the viewing area, or 
select at least 2 images in the browse menu.
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2. Once the images are added to the list, press “OK” to have the software begin processing of the images into a 
single image containing HDR.
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The “Extended Depth of Focus” function allows a user to capture multiple images from varying focal planes 
and assemble them into a single image with greater depth within focus than a single image. This is useful when 
viewing with high magnification, which has a limited depth of focus, or when capturing images of three dimen-
sional figures (such as when doing circuit board work, or viewing minerals).

Note: The EDF function can be used with previously captured images, or it can be used to capture images as 
part of the tool. We will display it as if capturing with the tool, however, the user has the choice to perform the 
image capture however desired. To use them from the browse menu, simply shift+left click all of the desired 
images to use in your stacked image, right click to bring up the context menu, and click the “EDF” tool from the 
list.

1. Clicking the “EDF...” tool will bring up the capture image option if no other images are currently captured in 
the viewing area. From here, move the focus of the microscope to the top of the range, so that it is focused on 
the topographical tallest plane of the sample you wish to focus on. In layman’s terms, focus it so that the tall-
est items in your sample are within focus. Typically, this means moving the stage or microscope head (depend-
ing on your microscope type) to the farthest point away from the sample while still focusing on a part of the 
sample.
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2. Once there, click “Capture,” and move the focus a little closer to the next plane of focus desired, and repeat. 
Repeat this process until you have focused through the tallest plane to the shortest plane (the closest that your 
microscope stage or head is to the sample before losing focus entirely). Clicking “Clear” will remove all photos 
from the list, so please use it only when needing to restart from the beginning. Once finished capturing photos 
while adjusting focus, press “Next” to continue.

Note: The more images captured in smaller increments of focus, the better the end image will be. Also, the 
reason we capture from tallest to shortest is because the images must be in sequence for the EDF tool to func-
tion correctly. If the images are taken out of order, they will need to be reordered before the tool will work 
correctly. Out of order images will cause strange focusing artifacts to occur when rendering the final image.
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3. The following menu allows the user to select the level of contrast used in the final image, and the rendering 
method for creating the final image. The software itself provides a fantastic detailed description of each func-
tion and when to use it, which can be seen below.

After selecting a method of rendering, please press “Next” to continue to the following menu.
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4. Next, we have the “Options” menu, which has various sliders to adjust for final image filtering and reproduc-
tion.

Detail Clarity - The higher this setting, the sharper the fine details will be in the field. Too much will look un-
natural, however.

Total Brightness - This affects brightness through the whole field including the sample. Use if your exposure 
was dark during capture to compensate, or if your exposure was too bright.

Background Brightness - This affects brightness only in the white or dark background of your image, detected 
based on contrast between color intensity and lack thereof for the background. Adjust this if your exposure’s 
background was too bright or too dark, but your sample itself was correctly illuminated.

The software, too, provides a good description of each in the menu, as seen below.

When ready, click “Next” to continue to the final menu.
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5. The final menu for the EDF process is the alignment options menu. Since there can be small variations in 
X- and Y- dimensions even when moving only the focusing knob (based on how a rack and pinion system is 
machined when moving forcus can cause variations), the auto alignment process attempts to correct for these 
variations to avoid a blurred image, or a misaligned image when stacking the images together.

As before, the menu has several notes as to this menu’s purpose and function, shown below. 

Setting it to “None” will assume that the images are perfectly align and will not perform correction processes.

Setting it to “Shift + Scale” will attempt to translate directionally as well as increase/decrease in size for best 
alignment.

Setting it to “Shift + Scale + Rotate” will do the same as above, however, will also rotate the image if it was 
rotationally skewed during focus translation of the stage.

When finished, press “Finish” to begin the software processing of the image stack.
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6. The software will process your image, and output an image that is deeply focused, providing a greater depth 
of focus.
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The “Deinterlace” function allows a user to take an interlaced image (one which is processed in a series of 
rows, displaying a partial or blurred image until all rows have been processed) into a deinterlaced image (one 
which displays at the same time. Interlacing is used to allow incremenetal loading of large resolution images 
on slower connections, at the expense of knowing when the image is done loading (such as with a progressive 
scan image, which will enlarge row by row until the full image is seen).

While the AmScope/ToupView software and cameras by default captured deinterlaced images, if a user wished 
to use our software to deinterlace ain image sent to them, this function can be performed here. The major 
benefit of a deinterlaced image is that it is processed row by row when displaying, and will enlarge until the full 
image is seen (easier to tell when it is fully loaded), and they are better to compress when using on the web or 
sending to other clients.

When an image is open, deinterlacing is performed by clicking the tool under the “Process” menu. It will be 
grayed out if no image is available to deinterlace. There are no adjustment menus to this process--deinterlac-
ing will be performed as soon as the tool is clicked.
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The “Color Composite” function is extremely useful for users wishing to highlight specific colors of their sample 
only, or, to view only specific color channels (such as in fluorescent light microscopy). Ultimately, it is a tool 
used for coloring and separating color channels in an image for highlighting areas of interest.

1. To use this function, a user will need to have captured an image in gray scale in the viewing area. This can be 
performed by capturing an image, then going to “Image” and “Mode,” then selecting “Gray Scale.”

2. Once the image is in gray scale, the user can then select “Color Composite” under the “Process” menu to 
bring up the first menu of the tool.
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3. This menu contains the core functionality of the “Color Composite” tool, with various options to adjust, as 
well as a place to add source images to work with. To begin, select the name of the source image to be used, 
and click “Add.” This will add the image to the color composite list, and bring up a new dialog menu asking 
which color this composite is to be.

Pick which color you wish to work with either from the slider, the palette, or the list of dyes/stains in the bot-
tom drop down menu, and hit “OK” when complete.
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4. Once the color is selected, the image will change with the selected color, and the slider options to the right 
will be enabled for adjustment. They are, left to right, positional adjustment (aligning multiple images is criti-
cal when you are coloring the gray images of the same image in for different color channels), brightness (B), 
contrast (C), and gamma (G). Background allows an image to be set as a non mixed image, so not affected by 
settings selected here, allowing, for example, a red dot on a blue background won’t turn the dot magenta.

The user may continue to add images, change colors, and turn layers on/off by clicking the color box next to 
the image name in the composite list. When finished, close the box, and the newly composited image will be 
displayed as its own new image file. To discard and start fresh, click the “New” button. Because of the flexible 
nature of the tool, experimentation by each user is necessary to provide best results for your stain/sample.
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The “Segmentation & Count” tool set is a very powerful set of tools in that it allows a user to create segments 
within an image, as well as use segmented areas to perform counting procedures. Because of the complexity 
and flexibility of this tool, there are a variety of different methods used to perform these functions.

The methods available to segment an image are shown in the “Segmentation & Count” menu expansion when 
hovering over the menu option under “Process.” Only one method can be used per image.
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Watershed... - This segmentation method is a mathematical morphology segmentation based on topological 
theory. This is done by taking the gray value of each pixel to indicate the altitude, and the boundaries of each 
local minimum value, and its impact area. This can be visualized by thinking of a flat plane with objects of vary-
ing height on it, and holes poked in the bottom, then immersed in a liquid. The liquid fills starting at the lowest 
point where a hole is, and fills up the basins between taller objects, where only the tallest show, like an island 
in an ocean. It is best for simple background objects with a large contrast between the background and the 
items of interest.

Approximation - Assigns whether the segments will be estimated as circles, ellipses, or none (the actual shape 
and size of the segment).

With Holes - This tick box enables the segmentation method to create holes within a segment for areas that do 
not fit the segment.

Outline Style - Assigns whether the segments will be colored in, outlined, or none (simply numbered).

Outline Color - Assigns which color the segments or outlines will be colored in.

Label Method - Assigns how the segments will be labeled. XOR contrasts the numbers against the background, 
true allows a color to be selected for all, and false eliminates numbering the sections entirely.

Label Color - When true is selected as the “Label Method,” will allow selection of the color to use for the num-
bering.

Label Type - When true is selected as the “Label Method,” allows selection between displaying counted seg-
ments, the area of each segment, or the perimeter of each segment.



86 MU Series (Windows)User’s Manual

Process Menu Tools
Segmentation & Count

Area (px) (Minimum & Maximum) - Allows the user to create an upper and lower limit for what the software 
considers a segment. Anything below the minimum or above the maximum value in area will be excluded from 
being a segment (in pixels). 
 
Perimeter (px) (Minimum & Maximum) - Allows the user to create an upper and lower limit for what the soft-
ware considers a segment. Anything below the minimum or above the maximum value in area will be excluded 
from being a segment (in pixels).
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OTSU Dark... - OTSU is a method to determine the threshold of an adaptive based on the gradation charac-
teristic of an image, then divide the image into the background and the targets of interest. The larger the 
difference between the background and the target, the large a difference is displayed between the two, while 
the smaller differences will be less displayed. Specifically, the dark method means the segment from the dark 
objects from the bright objects are determined using an OTSU algorithm, and is best used with a dark target 
object with a bright background. This method is best when you need accuracy, as it minimizes possibility for 
misclassification and missegmentation.

Approximation - Assigns whether the segments will be estimated as circles, ellipses, or none (the actual shape 
and size of the segment).

With Holes - This tick box enables the segmentation method to create holes within a segment for areas that do 
not fit the segment.

Outline Style - Assigns whether the segments will be colored in, outlined, or none (simply numbered).

Outline Color - Assigns which color the segments or outlines will be colored in.

Label Method - Assigns how the segments will be labeled. XOR contrasts the numbers against the background, 
true allows a color to be selected for all, and false eliminates numbering the sections entirely.

Label Color - When true is selected as the “Label Method,” will allow selection of the color to use for the num-
bering.

Label Type - When true is selected as the “Label Method,” allows selection between displaying counted seg-
ments, the area of each segment, or the perimeter of each segment.
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Area (px) (Minimum & Maximum) - Allows the user to create an upper and lower limit for what the software 
considers a segment. Anything below the minimum or above the maximum value in area will be excluded from 
being a segment (in pixels). 
 
Perimeter (px) (Minimum & Maximum) - Allows the user to create an upper and lower limit for what the soft-
ware considers a segment. Anything below the minimum or above the maximum value in area will be excluded 
from being a segment (in pixels).
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OTSU Bright... - The bright variant of OTSU is used to segment bright targets from dark backgrounds, such as in 
darkfield. Otherwise, it behaves the same as “OTSU Dark.”

Approximation - Assigns whether the segments will be estimated as circles, ellipses, or none (the actual shape 
and size of the segment).

With Holes - This tick box enables the segmentation method to create holes within a segment for areas that do 
not fit the segment.

Outline Style - Assigns whether the segments will be colored in, outlined, or none (simply numbered).

Outline Color - Assigns which color the segments or outlines will be colored in.

Label Method - Assigns how the segments will be labeled. XOR contrasts the numbers against the background, 
true allows a color to be selected for all, and false eliminates numbering the sections entirely.

Label Color - When true is selected as the “Label Method,” will allow selection of the color to use for the num-
bering.

Label Type - When true is selected as the “Label Method,” allows selection between displaying counted seg-
ments, the area of each segment, or the perimeter of each segment.

Area (px) (Minimum & Maximum) - Allows the user to create an upper and lower limit for what the software 
considers a segment. Anything below the minimum or above the maximum value in area will be excluded from 
being a segment (in pixels).
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Perimeter (px) (Minimum & Maximum) - Allows the user to create an upper and lower limit for what the soft-
ware considers a segment. Anything below the minimum or above the maximum value in area will be excluded 
from being a segment (in pixels).
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RGB Histogram... - This method segments a sample based on the image histogram, where pixels between a 
specific color and intensity range can be segmented away from the rest, or processed into another color if 
within or outside of the color range designated by the user. Limits can either be dragged to be set, or specific 
values used through user input. The color method used here is the RGB (red, green, blue) style. 

The numerical fields in the lower left corner of the dialog box when using the RGB Histogram method are the 
minimum and maximum values of that color to filter out or include. The user can either input precise values in 
there, or simply drag the limit bars along the histogram while viewing the results on the image itself.

The drop down menu next to it allows the user to select between red, green, and blue channels, each with 
their own minimum/maximum values.

The “Show All” tick box toggles between displaying a single channel and all channels in the histogram.

The drop down menu to the right allows the user to select what color the segments will be within the image.

The options menu allows the user to adjust the count parameters as shown in the previous two sections.

When complete, pressing “OK” will render the segmented image as shown below on the following page.
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HSV Histogram... - The “HSV Histogram” segmentation method is the same as above, however, uses HSV  (hue, 
saturation, and value) and style color values instead of RGB.
 

The numerical fields in the lower left corner of the dialog box when using the HSV Histogram method are the 
minimum and maximum values of that variable to filter out or include. The user can either input precise values 
in there, or simply drag the limit bars along the histogram while viewing the results on the image itself.

The drop down menu next to it allows the user to select between hue, saturation, and value channels, each 
with their own minimum/maximum values.

The “Show All” tick box toggles between displaying a single channel and all channels in the histogram.

The drop down menu to the right allows the user to select what color the segments will be within the image.

The options menu allows the user to adjust the count parameters as shown in the previous two sections.

When complete, pressing “OK” will render the segmented image as shown below on the following page.
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Color Cube... - This segmentation method may prove to be the most complex and the most user friendly simul-
taneously, as it allows a user to select specific pixel colors to be segmented out using a color pipette tool, and a 
+/- tolerance setting. While flexible, it does take a good deal of time and patience to manually select the color 
pixels the user wishes to work with.

The + and _ icons with the pipette allow the user to add pixel colors or remove pixel colors from the segmenta-
tion divisions. 

The drop down menu next to it selects how large the circle of pixels is selected by the pipette, with the average 
of the area selected being the actual color added to the segmentation.

The tolerance section allows the user to create a margin of error used when selecting a color. A greater toler-
ance will allow more variance in color of the pixels selected based on the color clicked, while less will mean 
only precise colors near what was picked will be segmented.

The “Options” section will bring up the counting parameters as in the above sections.

When finished clicking pixels to select your segmentation area, click “OK” to render the final image, as seen in 
the following page. 
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Split Objects - “Split Objects” is a tool to be used, rather than a segmentation method. If using a segmentation 
method results in a segment adhering to another segment (as in, they show up as a single segment when they 
should be two unique segments), the object select tool can be used to manually select a segment, and split 
them manually into two segments. Note that this will require a bit of drawing using the mouse, so, accuracy is 
dependant on the user and how steady their hand is for mouse manipulation.

Count Result... - “Count Result...” is another tool used to display statistics of the counted data from the above 
methods. Some statistics it can cover are index, center, radius, area, and perimeter of the counted items within 
the field of view.
 



98 MU Series (Windows)User’s Manual

Process Menu Tools
Denoise

The “Denoise” function provides a method for a user to do just that--remove “noise” from an image. Noise, 
in terms of digital photography, is considered random variation of brightness or color information in digital 
images, usually caused by electronic device interference from the sensor or circuitry of the device itself. It ap-
pears as extra information in the form of pixel colors that were not present in the object imaged.

The “Denoise” menu contains three different methods of identifying and removing noise from an image.

Adaptive Wiener Filter - This method preserves more detail than those of the median, mean, and Gauss style 
filters. This is the best method to select to remove Poisson and Gaussian noise (additive and multiplicative 
style noises). Noise levels are automatically calculated since they are difficult to estimate and precisely enter. 
This is also the most hands off method of noise removal. Once this method is selected, it automatically takes 
effect--no dialog menus will appear.

Bilateral Filter - This method considers spatial proximity, pixel value similarity, image spatial information, and 
gray levels to preserve edges while performing the denoising process. If your sample has many edges that are 
critical to maintain for clarity, this is the ideal method to use.
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The “Value Domain” slider refers to the range that the software uses to analyze the neighboring pixels to an 
area suspected of noise. The higher this is, the longer the image will take to process, as it averages a larger 
area per pixel. Too large may cause strange artifacting, so it’s best to keep it near the mid point of the slider 
and adjust in small increments as needed.

The “Space Domain” slider refers to how strong the denoising effect will be. The higher this value, the more 
aggressively the software will detect rogue pixels as noise. Best kept to the lower end of the spectrum as too 
high, and many items in your image that are as pictured correctly may be averaged out, losing out on image 
quality.

Non Local Means - This method uses a weighted average of pixels over a given area to extrapolate what is 
noise and what is not over a separate area not adjacent to the search area. This allows a user to denoise more 
accurately than only denoising over a local area via the adjacent pixels, and provides greater flexibility in repro-
ducing accurate to object images.

The “Strength” slider refers to the aggressiveness of the software’s noise removal. The higher this is, the more 
noise will be removed, however too  high and detail will be lost beyond jut noise.

The “Template Window” slider refers to the template block size, and is used to calculate the weight at which 
the pixels will be averaged when a noisy pixel is detected based on the template area.

The “Search Window” slider is used to calculate how large of an area will be averaged when a noisy pixel is 
found in the target area for denoising.

When finished adjusting the sliders, press the “OK” button to engage the software’s denoising process. The 
resulting image will be displayed once complete.
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The “Sharpen” function attempts to create a crisper and cleaner image with more defined lines, and is useful 
for when an image is just slightly out of focus and would benefit from a small adjustment. Note that sharpen 
does not clear up out of focus images, so it’s always better to take a correctly focused image (or use EDF if 
needing greater depth of focus) before looking to use the “Sharpen” function.

The “Sharpen” function has two different methods.

UnSharp Mark... - Contrary to it’s odd sounding name, the “UnSharp Mask...” method is actually a sharpen-
ing method. The name comes from the process it uses to create a sharper image by taking an unsharp positive 
image with a negative of the original image and merging the two in order to create additional contrast in the 
positive image.

The “Radius” slider refers to the size of the edges to be enhanced. Larger settings tend to cause halos around 
edges, so, use sparingly to ensure fine details are enhanced without ghosting. Also, threshold and radius are 
related in effect, and thus, lowering one will allow the other to be increased if needed.
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The “Threshold” slider adjusts the minimum brightness change that will be sharpened. Adjusting this up can 
produce more pronounced edges, while leaving subtler edges untouched, however, they can exclude areas of 
lower contrast.

The “Amount” slider quantifies, as a percentage, how much darker and how much ligher edge borders become. 
Another way to visualize it is how much contrast is added at the edges.

Laplacian Sharpen - The “Laplacian Sharpen” method is used to sharpen any detail in an image, however, 
because it sharpens any discontinuity, things like noise can also get sharpened. It’s recommended to use a 
“Smooth” function and/or a “Denoise” function prior to using the “Laplacian Sharpen” method to ensure that 
the fine details enhanced by this method are not used on items that should not be highlighted. No parameters 
are provided for this sharpen method, so its effects will occur as soon as the tool is clicked.
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The “Color Toning” section contains various functions regarding how an image’s colors are displayed on a 
monitor. It does not actually adjust the monitor’s settings, but, allows you to compensate an image’s values to 
adjust how it is displayed on a monitor.

Gamma - This function allows a user to measure and adjust the amount of brightness that the midtone colored 
pixels have in an image as produced by a display device (such as a monitor). The higher this slider is positioned, 
the darker the midtones will appear. 

Note that this is not controlling the actual gamma setting of your monitor, but, is a software adjustment for the 
image itself based on how a monitor displays these midtones.
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Histogram Equalization - This function uses a digital image processing technique to improve contrast in im-
ages by computing several histograms, each corresponding to a distinct section of the image, and uses them to 
redistribute the lightness values of the image. 

It is best used to ajdust local contrast levels, howeer, noise can be amplified, so it is best to wait to use this 
function until the image has been run through a “Denoise” process, then a “Smoothing” process, before using 
the “Histogram Equalization” function.

The “Strength” slider is used to quantify how aggressive the equlaization of the histogram will be. The larger 
the value, the more equalized it will be, and thus, the largest effects will be seen in the final image.
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Local Color Correction - This function is a digital enhancement used to enhance colors that may have not been 
accurately reproduced by the software and camera sensor on initial capture. It uses a two step algorithm to 
detect and adjust the image correctly.

The first step is that the software creates a mask image computed from the intensity of each color in an image, 
defined as the average of red (R), green (G), and blue (B) pixel values. Intensity information helps the algorithm 
avoid distortions of the chroma (colors). The mask itself is then created by inverting and blurring the intensity 
component of the input image (using the negative of the image). The mask is then combined with the input 
image to get the final result, much like the “UnSharpen Mask...” function.

The combination aspect consists of a power function where the exponent is computed using the mask value 
previously found. If the mask is greater than 128, it will result in an exponent less than 1, while if the mask 
value is lower than 128, it will result in an exponent greater than 1. If the mask value is precisely 128, the expo-
nent will be 1, and won’t have an effect on the input image. It can be thought of as a pixel-wise gamma correc-
tion.

The “Strength” slider quantifies how strong the color correction function will be, where the larger the value is, 
the more aggressively the colors will be toned.

Adaptive Multi-scale Retinex (AMSR) - This function is a digital enhancement used to improve the perfor-
mance of the dynamic range captured by the camera sensor. Typically, images are processed using a low 
dynamic range (low range between minimum and maximum contrast values) in order to display on common 
monitors, which tend to be low dynamic range display devices. By adjusting from MSR to AMSR, there is a no-
ticeable increase in dynamic range, color consistency, and color reproduction.

Because the AMSR function does not have a dialog box or parameters to be input, once the function is clicked 
on, it will automatically perform the enhancement process.
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The “Filter...” menu option contains a number of functions that perform different filtering processes for image 
enhancement purposes. For those familar with Adobe Photoshop, or other Adobe Suite products, many of 
these filters will be familiar to them, falling under categories such as “Image Enhance,” “Edge Enhance,” “Mor-
phological,” and “Kernel.” Note that the “Filter...” function will be grayed out unless a photo is available for 
filtering in the viewing area (the live view cannot be filtered, only a snapped still image can be used).

Clicking on the “Filter...” option will bring up the dialog menu containing a number of available filters to use 
with the AmScope/ToupView software, containing the four tabs mentioned above-- “Image Enhance,” “Edge 
Enhance,” “Morphological,” and “Kernel” tabs. Each one contains various filters and parameters for each that 
can be set to alter the effects of the filter.
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Image Enhance - The first tab for the “Filter...” menu is the “Image Enhance” menu, containing filters used to 
enhance the overall image’s appearance. the filter options are as follows:

Low Pass - This filter softens an image by eliminating high frequency information (blurring sharp edges). The 
center pixel is replaced with the mean value in the neighborhood assigned. This works well for noise removal.
 
High Pass - This filter enhances high frequency information, replaciang the center pixel with a calculated value 
that significantly increases its contrast from its neighboring pixel area. Leaving only elements of high contrast 
in an image is the hallmark of the “High Pass” filter.

Gauss - “Gauss” is a method of softening an image by eliminating high frequency information to blurr an im-
age, softening sharp edges. This method is similar to the “Low Pass” method, but, degrades the image less 
than the “Low Pass” filter.

High Gauss - This method of filtering enhances fine details, similar to the “UnSharp Mask...” method, but intro-
duces less noise to the image, using a Gaussian curve kernel to perform the filter processing.

Equalization - This filter is used to enhance the contrast based on the histogram of the local neighborhood.

Sharpness - The “Sharpness” filter enhances fine details, attempting to refocus a slightly blurred image. This 
uses the “UnSharp Mask...” technique.
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Flatten - This filter attempts to remove the topography of an image by equalizing gray values, creating a flatter 
image.

Median - This filter removes impulse noise from an image by replacing the center pixel with the median value 
of its neighboring pixel area, also slightly blurring the image.

Rank - This filter removes impulse noise from an image by ranking kernels in the order of intensity, and the pix-
els within the range at a given percentage are chosen for comparison. If the difference between the selected 
pixel and the center pixel is greater than the threshold value, the “Rank” filter replaces the value of the center 
pixel with the value of the selected pixel.

Options - This section also contains a number of paramters that can be adjusted depending on which filter is 
being used.

Using a “3x3” kernel will produce a more subtle filtering, while “5x5” will produce a moderate effect, and “7x7” 
will produce a stronger effect.

“Passes” refers to the number of times the filer is applied to an image. The more passes, the more amplified 
the effects will be,

“Strength” is a percentage derivative, where each value represents 10% strength of the filter application. 10 
thus provides the full strength of the filter of 100%, the greater the value, the greater the difference between 
the filtered pixel value and the original pixel value will be.

When “Rank” is selected, the “Strength” parameter will disappear, and the “Rank” parameter will appear. This 
value specifies which pixel in the sorted (ascended) pixel array will be used to replace the center pixel. Pixels 
are indexed from 0 to Kernel x Kernel -1, where 0 corresponds to the lowest value. The “Rank” will be specified 
in the terms of a percentage of the indexes, where a 50% rank means in the middle pixel in the array, a 0% rank 
means the lowest gray value, and a 100% rank means the highest gray value.

When the “Equalization” filter is selected, the parameters will change to adjust the histogram equalization 
values, instead of the “Passes” and “Strength” parameters.

The “Window” option uses pixel statistics (minimum, maximum, histogram, mean, standard devication, etc) of 
an area in the image, then used to device the local contrast for that area of the image. Larger windows provice 
smoother results, while smaller ones make more intense changes to small details.

The “Best Fit” option optimizes the values for the particular image based on the software’s interpretation of 
the image by stretching the local histogram to maximize the contrast between brightest and darkest pixels in 
the window region.

The “Linear” option distributes the histogram linearly across the intensity scale, providing a high contrasted 
image with the highest possible dynamic range.
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Using the “Logarithmic” option concentrates the histogram at the low end of the scale, providing a high con-
trast image with little dynamic image. It tends to overall darken the imaeg, and is useful for increasing contrast 
when your sample image is very light.

The “Exponential” option concentrates the histogram at the high end of the scale, and is useful for increasing 
contrast in a very dark image.

Edge Enhance - The “Edge Enhance” set of filters are designed to provide addtional contrast for the edges of a 
sample, rather than enhancing the total image overall. These are best used for when the shape of your sample 
is what is being reviewed, moreso than overall composition.

Sobel - This filter enahnces just the principal edges in an image by applying a mathematical formula to a 3x3 
pixel neighborhood to locate and highlight edges.

Roberts - This filter enhances fine edges in an image by applying a mathematical formula upon a 4x4 pixel 
neighborhood to produce its effect. The upper left pixel in the neighborhood is the one that is replaced.

Sculp - The “Sculp” filter applies a sculpted effect on the image, as if it was carved out of a material.

Horizontal - The “Horizontal” filter detects and emphasizes horizontal edges.

Vertical - The “Vertical” filter detects and emphasizes vertical edges.
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When an “Edge” filter has been checked, the options parameters will relate to the kernel size and filtering 
strength for that specific filter, displaying the following options:

3x3 - Checks are done by 3x3 kernels to produce a more subtle filtering effect.

5x5 - Checks are done by 5x5 kernels to produce a moderate filtering effect.

7x7 - Checks are done by 7x7 kernels to produce an aggressive filtering effect.

“Passes” refers to the number of times the filter is applied sequentially. The more passes, the more times the 
filter is applied.

“Strength” is a percentage derivative, where each value represents 10% strength of the filter application. 10 
thus provides the full strength of the filter of 100%, the greater the value, the greater the difference between 
the filtered pixel value and the original pixel value will be.

Note: No paramters will be available as options if “Sobel” or “Roberts” are checked.

Morphological - The “Morphological” filter set is a filter set to be used when alteration of the image itself is 
called for, such as modifying size or shape of objects for correction purposes. A variety of available filters allow 
various morphologies to be achieved, such as “Erode” and “Dilate” filter methods.
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Erode - This morphological filter is useful when a user wishes to modify the size of the objects in the image, as 
it erodes the edges of bright objects and enlarges the edges of dark ones.

Dilate - The “Dilate” filter if used if one wants to modify the size of the objects in the image, as it erodes the 
dark objects and dilates the bright ones.

Open - This filter is useful if one wishes to modify the shape of objects in an image. If the image contains bright 
objects on a dark field, the “Open” filter will smooth object contours, separate narrowly connected objects, 
and remove small dark holes.

Close - This filter is useful if one wishes to modify the shape of objects in an image. If the image contains bright 
objects on a dark field, the “Open” filter will fill gaps and enlarge protrustions to connect objects that are close 
together.

Tophat - The “Tophat” filter detects and emphasizes points, or grains, that are brighter than the background. 
There are 3 kernel sizes for this filter process. The radio buttons allow the user to select between them to se-
lect which best fits the grain size to detect.

Well - This filter detects and emphasizes grains that are darker than the background. There are 3 kernel sizes 
for this processing method. The radio buttons change the size of the kernel--picking the one most closely 
matching the grain of the desired detection area provides best results.

Gradient - The “Gradient” filter enhances edges in an image.

Watershed - The “Watershed” filter separates objects that are touching by eroding objects until they disap-
pear, then dilating them again, preventing them from touching. “Watershed“ doesn’t work with True Color 
images, so, it must be converted to “Gray Scale” mode first before this will function.

Thinning - This filter reduces the image to its bare skeleton. When choosing this filter, the user must set the 
threshold that determines whether a pixel is part of the subject or the background. Like the “Watershed” filter, 
the image must be in “Gray Scale” mode before it will function. 
 
Distance - The “Distance” filter is used to show the distance of pixels within blobs to the outer boundaries of 
those blobs. After applying the distance filter, the background will be black. Only the area within the blobs will 
have non-zero values (white). The values of each pixel within the blob will be a count of the shortest distance 
from that pixel to the edge of the blob. Thus, all pixels a long the blob’s border will have a value of 1 since they 
are one pixel away from the blob, while pixels that are a distance of 2 from the border will have the value 2, 
and so on. This creates a distance map of the image. Like the above, “Gray Scale” mode must be used for this 
filter to work.
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There are various option parameters available, depending on which filter is selected.

If the “Erode,” “Dilate,” “Open,” or “Close” filters are selected, the parameters available will refer to the kernel 
size and shape, such as :

2x2 Square - Uses a 2x2 square kernel.
3x1 Row - Uses a 3x1 row kernel configuration.
3x3 Cross - Uses a 3x3 cross shaped kernel.
5x5 Circle - Uses a 5x5 circle shaped kernel.
7x7 Circle - Uses a 7x7 circle shaped kernel.
11x11 Circle - Uses an 11x11 circular kernel, which is a three-pass filter using a 5x5 circle, another 5x5 circle, 
and a 3x3 cross.

The “Passes” parameter sets how many times the filter will process over the image sequentially.

Note: Circular kernels are effective on round objects (cells, grains, etc) because their circular configuration pre-
serves the circular shape of objects better than square ones when processing.

If the “Tophat,” “Well,” or “Gradient” filters are selected, the parameters will also relate to kernal size and 
shape, with the following options:

3x3 - Uses a 3x3 square kernel
5x5 - Uses a 5x5 square kernel
7x7 - Uses a 757 square kernel

If the “Watershed,” “Thinning,” or “Distance” filters are selected, the parameters will alter the threshold of 
each filter. The “Threshold” slider allows the user to enter a percentage value from 1-100 that specifies the in-
tensity value of image binarization. The image is presented in gray value, and the percentage and below num-
ber of gray values will be set to black, whereas the rest will be set to white. 100% would turn everything white, 
0% would turn everything black.

Kernel - The final tab for the “Filters” menu are the kernel files for morphological and convolution style filters. 
This menu allows advanced users to alter the kernels to customize the filter use. Note that this is for advanced 
users only--if unsure how any of these work, we recommend leaving this section alone, as deleting or modify-
ing a core kernel without creating a new kernel will require a reinstallation to fix.
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Kernel - The final tab for the “Filters” menu are the kernel files for morphological and convolution style filters. 
This menu allows advanced users to alter the kernels to customize the filter use. Note that this is for advanced 
users only--if unsure how any of these work, we recommend leaving this section alone, as deleting or modify-
ing a core kernel without creating a new, separate kernel will require a reinstallation to fix.

Note: HiPass, LowPass, Laplacian, and Unsharp kernel files are used by the HiPass, LowPass, Laplacian, and 
Sharpen options in the Image Enhancement Filters page dialog window. Because these kernels are essential to 
the operation of these functions, they must never be deleted or renamed.

AmScope staff is only capable of supporting the kernels and filters as provided with the software. Support can-
not be provided for creating or using custom kernels.
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“Image Stacking” is a method form of speckle imaging used for obtaining high quality images from a number 
of short exposures with varying image shifts. Astronomers use this method as well as many image stabilization 
functions on cameras. 

By calculating differential shifts of the images based on location of items within the image (such as stars), the 
images can be aligned and averaged together, creating signal to noise ratio increases and dynamic contrast 
ranges. For microscopy, this is best used for fluorescent imaging and many biological microscopy techniques 
that require low light environments.

The “Image Stacking” tool is used by recording a short video to get a high quality set of images at ease without 
worrying about image rotation, shifting, or scaling between the series of images.

1. Begin by capturing a short video of the sample desired to image stack, or locating a video that the user 
would like to use that was pre-recorded. It does not need to be moved in any direction, nor moving. The more 
still the video, the better the final stacked product will be.

2. When ready, click the “Image Stacking...” function in the “Process” menu. The software will open a browse 
window, asking which video it should use for image stacking. Select the correct one, and hit “OK.” Note that 
the software supports .wmv, .asf, .avi, .mp4, .m4v, .3gp, .3g2, .3gp2, .3gpp, .mov, .mkv, .flv, .rm, and .rmvb file 
formats for image stacking.

3. The software will scan the video and process multiple frames into alignment, then average them, to provide 
the stacked image as the final result once processing is complete.
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The “Line Profile” function allows a user to illustrate how pixels along a selected line are distributed by graphi-
ing the number of pixels at each color intensity level along that line.

1. Begin by clicking the “Line” tool in the top tool bar, and drawing a line where you would like to check the 
color intensity of the pixels.

2. Click the “Process” menu, and click “Line Profile...” to generate the line profile graph.
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Below shows an example of the image line profile tool in use, where each color and intensity is individually 
graphed.

In the above line profile, the X-axis represents the spatial scale of the line, and the Y-axis represents intensity 
values ranging from 0 to 255. A gray scale image will provide a gray value instead of RGB (red, green, blue) his-
togram. If the image is an HSV image, RGB will be replaced with HSV (hue, saturation, value).

The “Background” button opens the window color dialog box to allow you to adjust what colors are considered 
the background, and which are considered for the line profile.
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The “Title” button allows the user to set a title for the graph.

Pressing “Capture” will save the line profile graph as an image for later recall.

“Copy” will copy the contents of the “Line Profile” graph onto the clipboard.

“Save As...” allows the graph to be saved in a .bmp format.
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The “Surface Plot” function generates a three dimensional representation of the intensity of an image, much 
like the “Line Plot” function, however, over an entire image. This is performed by considering the X (image 
width), Y (image height), and Z (pixel gray value) variables. The more intense (higher grey value) a pixel, the 
taller it is on the topographical mapping of the image, while X and Y refer to the position of the pixel.

1. Begin using a captured image, and click “Process” and “Surface Plot...” to open the 3-D Setup menu. The 
software will render a three dimensional sculpture of the image’s topography based on pixel intensity (gray 
value), and allow you to modify several parameters to create the best result for your specific sample.
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A similar window to below should appear, baed on what sample was captured (colors may differ based on 
what the software feels provides the best contrast). Elevation and rotation of the rendering can be adjusted by 
clicking and dragging in the direction you’d like to move the rendering (turning, pivoting, etc).

Position Solid - The first option presented allow the user to indicate the relative position of the entire image. 
By default, this value is 0.5, as in, based on the color intensity scale, 50%. Usually this results in the image be-
ing centered, however, it can be adjusted if particularly high or low intensity values are being reported.

The second value determines the scale of the gray values used to create the topography. 1 is default for a 100% 
scale. Increasing this number will create a larger rendering by manipulating gray values up/down by the num-
ber indicated (in 10% increments per 0.1), while a number less than 1 will flatten the image more (useful if 
there are naturally large gray values causing high peaks).

Image Background Color - This drop down allows the user to select what color the background will be. “Reset” 
allows the user to reset the “Position Solid” numbers to default.
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Capture - The “Capture” button saves the active image in the viewing window as a new image.

Color Table - This function allows the user to select which colors to map the gray values found in the surface 
plot. The drop down menu at either end of the table spectrum open up color selection dialog windows, with 
defaults and custom color options to select.
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The “Pseudo Color” function requires an image to be in the “Gray Scale” mode, however, allows the user to 
colorize the active image. This is particularly useful when needing to highlight certain features in a sample only. 
Essentially, it takes gray values as a spectrum, and applies whichever color the user has designated to those, or 
if a thermal image is captured, to color above a certain gray value in that color.

1. Begin using a captured image saved in “Gray Scale” mode, and click “Process” and “Pseudo Color...” to open 
the color table. These colors can be selected to assign what color the gray values should be, much like in the 
“Surface Plot” color spectrum selection. The entire image will be ranged and assigned a color based on the 
gray value (intensity) in alignment with the spectrum. 

Note: Unlike a palette class image (like the orginal photo), the colors applied here are not included in the im-
age file, as they are simply a color swap for gray values over a gray scale image. 
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2. The above color spectrum settings result in an image like seen below:
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The “Range” command allows the user to set the upper and lower intensity level limits of the image to in-
crease the contrast and enhance the display in low light situations.

1. Pressing the “Range...” menu function will bring up the “Range” dialog box, providing the user with the 
ability to adjust the upper and lower intensity limits by either dragging the limit lines in the graph or inputting 
exact values in the numerical areas in the upper section.

All values between 0 and the lower limit will appear as black, while all values between the upper limit and 255 
will be white. The various buttons allow the user to manipulate the numbers in a quick manner.

“Best Fit” automatically sets the range, while “Invert” changes the scale from 0-255 to 255-0. “Reset” starts 
over. “Update” will refresh the display range with the current image in the viewing area.



123 MU Series (Windows)User’s Manual

Process Menu Tools
Binary

The “Binary” function processes the image based on the gray value of each pixel, into a binary system (black 
or white). Pixels above a threshold will be turned white, while those below will be turned black. This is mainly 
used as a step in a process for other tools, however, can be used on its own if preferred, although some detail 
and data is lost in the image.

The numerical value allows you to set the threshold between 0 and 255 where the binary division is, while 
“Best Fit” automatically selects that threshold for maximum retention of detail.



124 MU Series (Windows)User’s Manual

Layer Menu Functions
Layer Menu

The “Layer” menu is used to manipulate the various measurement and annotation layers available for use with 
a captured image. Layers allow a user to non-destructively create overlays, measurements, and annotations on 
an image, with the ability to hide them if desired, and recall them later. Without using layers, anything placed 
directly on the image would become a permanent fixture of the image, and thus, one would have to start over 
if needing to make modifications. Note that a visual representation of the layers in an image can be found at 
the bottom of the left navigation bar, in a tab named “Layer”.

New... - The “New...” function creates a new layer in the image and allows the user to input a name for it.

Remove... - This menu function will delete the currently visible layer.

Current... - The “Current...” function brings up a drop down menu allowing the user to select which layer they 
wish to have active.

Show/Hide... - This allows a user to make a layer appear or disappear in the total image view, without deleting 
it.

Rename... - Allows a user to modify the layer name of a previously created layer.

Export to Image - Exports the current layer to a new image of its own, useful for later recall if needed.

Export to Microsoft Excel - Exports the current layer’s data to a Microsoft Excel sheet.
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The “Measurements” menu is a drop down representation of the measurements tool bar, as covered in the 
earlier sections of this manual. The only new additions to this are the “Z Order” and “Scale Bar” tools, which 
we will cover here. Note: All of these tools will show values in pixels (px) unless calibrated to a unit of known 
measurement. Please see the “Calibration” section under “Options Menu” in this manual for instructions on 
calibration.

Scale Bar... - This menu option enables the user to place a scale bar on the image for easy reference of size.

Z Order - “Z Order” contains a menu that refers to the position of an item relative to other items superimposed 
on the image, much like the layer system, and allows manipulation of items to appear in front of or behind 
each other by moving them along the “Z” dimension (depth).
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The “Options” menu is a drop down section containing various sets of parameters that can be adjusted to 
change the behavior of the software, from default file types to default save directories, color palette lists, and 
saved magnifications and calibration settings. These available sections will each be covered in more detail on 
the following pages.

Preferences... - The “Preferences...” option brings up a series of menus that allows you to alter the core behav-
ior of the AmScope/ToupView software, such as file paths and types to save files in, grids, cursor behavior, and 
more.

Measurement... - The “Measurement...” option opens a series of menus allowing changing of the label colors, 
significant figures, and other various options regarding how measurement tool outputs are displayed.

Magnification... - The “Magnification...” option will open a list of all the currently saved magnification options.

Calibrate... - The “Calibrate...” tool allows a user to use a micrometer slide or ruler (any unit of known mea-
surement visible through the microscope) to tell the software how many pixels (px) are in a unit of known 
measurement (inches, millimeters, microns), allowing the software to extrapolate real distances in a sample at 
a given magnification. This process is covered in more detail in its own section, as it is a frequently asked ques-
tion.

Edit Dye List... - The “Dye List” is the list of stains commonly used and their emissions and excitation baries, as 
well as the color spectrum. This allows a user to add their own stains to the list, useful when using post pro-
cessing and individual color channeling to enhance contrast results in an image.

Auto Correction... - This menu option brings up the automatic setting adjustments, allowing a user to adjust 
how aggressively the automatic functions behave.
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The “Preferences” menu, as shown below, contains several pages of parameters that affect the core working of 
the software.

Quick Save - The “Quick Save” tab refers to parameters that control how the “Quick Save” tool functions.

“Directory” is the folder in which the files are saved.

“Name Format” refers to how the images will be named (numbered in sequence, etc).

“File Prefix” allows a user to designate an alphanumeric prefix to be placed before the file name.

“File Type” refers to the file extension used to save the photos (.png, .jpg, etc).

“Option” allows the user to set whether the images will be interlaced or not.

“Sample” feeds back what the file name will appear as if “Quick Save” is used based on the current settings.
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Options Menu Functions
Preferences Menu

File - The “File” tab refers to the file extensions the software is capable of using, and whether or not those file 
extensions should show in the “Browse” mode.
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Options Menu Functions
Preferences Menu

Print - The “Print” tab provides parameters for what appears on an image if printed directly from the Am-
Scope/ToupView software.

“Page Header” places a note on the top of the printed image in the header of the print out. The “&p” param-
eter refers to what page it currently is printing, while the “&P” parameter (case sensitive) refers to the max 
number of pages in the print job.

“Page Footer” is the same thing, however, for the bottom, or footer, of the printed images. The “%Y” param-
eter refers to the year, while the “%m” parameter is the month, and the “%d” parameter is the date of the 
current month.

“Print the measurement items,” when ticked, will print the measurements drawn on the image with the print 
out.

“Print the measurement table” will print out a table of specifications of the measurements on the drawing in 
addition to the image, when ticked.

“Page Usage” refers to whether the measurement table will  be printed on the same sheet, another sheet, or if 
no preference is given, whichever is the best fit.

“Font” allows the user to select which font and font size should be used for the printed information.
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Options Menu Functions
Preferences Menu

Grid - The “Grid” tab provides parameters for what appears on an image when the grid functions are enabled 
and overlayed on an image in the viewing area.

“Style” allows the user to select whether the software should automatically populate a grid, if the user wishes 
to manually make a grid, or if no grid is to be applied to new images.

“Line Style” gives the user a choice between how strongly rendered the lines in the grid will be, depending on 
what style is selected.

“Line Color” allows the choice of what color the grid lines will be in the image, useful for ensuring that there is 
enough contrast to clearly see the grid division lines.
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Options Menu Functions
Preferences Menu

Cursor - The “Cursor” tab provides parameters regarding the mouse cursor when in the viewing area, allowing 
greater contrast and visibility by adding vertical and horizontal line features, or changing the cursor itself, or 
both.
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Options Menu Functions
Preferences Menu

Capture - The “Capture” tab provides two options for users to select--whether they would like the image to 
capture with the marker and watermark, capture with the measurement annotations, capture with both, or 
capture neither.
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Options Menu Functions
Measurement Menu

The “Measurement Menu” contains various adjustable parameters for the behavior of the measurement tools. 
Note that like other measurement functions, all items will show in pixels (px) unless the calibration process has 
been completed.

General - The “General” tab allows the user to change parameters such as significant figures shown, font ap-
pearance, and display of specific items.

“Calculation Results Keep” allows the user to choose how many significant figures are involved when displaying 
measurements and calculations.

“Label font size” adjusts how large the font used to display measurement labels appears.

“Label color” changes the display color of the label.

“Dimensions with unit,” when ticked, shows the name of the dimension as well as the unit, such as inches, mil-
limeters, etc.

“Label with name” allows the user to toggle whether the name of the label will be displayed with the label or 
not.
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Options Menu Functions
Measurement Menu

Length Unit - This menu contains a record of units of measurement the software has input. 

Note that unless these are calibrated using the calibration process, they still will not work as a selection for 
method of measurement. These are only unit names (the software still needs calibration for measurement at 
given magnification to extrapolate data.)
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Options Menu Functions
Measurement Menu

Length Unit - This menu contains a record of units of measurement the software has input. 

Note that unless these are calibrated using the calibration process, they still will not work as a selection for 
method of measurement. These are only unit names (the software still needs calibration for measurement at 
given magnification to extrapolate data.)
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Options Menu Functions
Measurement Menu

Angle Unit - This menu allows the user to select which unit angles are measured in.

The drop down menu contains the various angular measurement units, while the tick box, when checked, 
shows all angle units in the measurement side bar, or hides them all if not desired.
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Options Menu Functions
Measurement Menu

Sheet - This menu allows the user to select which parameters they wish to have displayed on the measure-
ment sheet.

The “Up” and “Down” buttons allow the user to sort the order they appear on the sheet, while “Default” sets 
them back to factory order.

When ticked, each item will display on the sheet, while when unticked, they will not appear.
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Options Menu Functions
Measurement Menu

Object - This menu allows the user to select which parameters they wish to have displayed on the measure-
ment sheet, based on which specific tool is used to create that measurement.

Each section will be labelled with the tool it affects, such as “Point” and “Line.” Each section allows modifica-
tion of the colors, style, size, and units of the tool, and of other components of the tool. Each section explains 
itself rather thoroughly, and each individual section will not be covered in this manual.
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Options Menu Functions
Magnification Menu

The “Magnification” options menu allows the user to modify the list of saved magnifications the software has 
based on calibation processes previously performed.

“Import...” and “Export...” can be used to save calibration data tied to measurements as a file, to be imported  
with a new system. Nothing will appear in this section until calibration procedures have been performed.
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Options Menu Functions
Calibration Menu

The “Calibration” options allows the user to input a rule for the software to use to determine how much of a 
unit of real distance is equivalent to how many pixels the camera sees, at a given magnification. These rules are 
used to perform calculated measurements while using the camera and software, giving much needed flexibility 
for measuring small features in any type of a microscope. Note that this process must be repeated for every 
magnification (and ideally, every unit of measurement) that the user intends to measure at. Using a setting at 
a different magnification than calibrated will cause massive discrepancies between actual distance and mea-
sured distance.

1. Begin by switching the magnification on your microscope to your desired calibration setting, and placing a 
unit of known measurement on the stage. The smaller the division, the more accurate the measurement func-
tions will be, down to 0.01mm (the smallest guaranteed accuracy level of the camera and software).

2. Focus on the micrometer slide or ruler while looking at the live feed. Once focused and set, adjust the live 
resolution to the highest available setting, set the zoom to 100%, and the unit of measurement to pixel, in the 
upper toolbar.

3. Proceed to the “Options” menu, and hit “Calibration.” The above “Calibrate” menu will appear, with a red 
line overlayed on the image. Adjust the line to position it on the 0 point of your ruler, and the first unit of mea-
surement (such as 1mm if using a ruler, or 0.01mm if using a micrometer slide), so that the line spans between 
the two points.
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Options Menu Functions
Calibration Menu

4. Input the actual length in real distance drawn (0.01mm if using a micrometer slide, for example), and set the 
magnification drop down to the magnification value being used.

5. Once complete, click “OK” to save the calibration. Now, whenever the setting you input under “Magnifica-
tion” is selected and the measurement unit is changed to the unit you provided, and it will display that mea-
surement instead of pixels.

6. Repeat the process as necessary until all magnifications and units of measurment have been calibrated. This 
allows the software to work at those given magnifications without recalibrating, easily swapping right on the 
upper tool bar as needed.

7. Although having all magnifications possible with the microscope (or at least those intended for frequent use) 
is convenient, and the software will not lose accuracy over time, depending on the type of microscope, getting 
the exact magnification previously calibrated at may be difficult (especially for zooming stereo microscope us-
ers). Because of this, it is recommended to recalibrate at the given magnification prior to measuring for opti-
mum accuracy, if time permits.

8. If the magnification desired to calibrate at is not present in the drop down menu, the user may type in your 
own name, and it will accept the typed characters. This way, custom magnification settings can be input and 
saved for later recall--very useful for stereo microscope users.
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Options Menu Functions
Edit Dye List Menu

The “Edit Dye List...” options menu allows the user to edit the dye list to add custom dyes used in staining a 
sample, useful when performing fluorescent microscopy, and with use with the color tools/functions.

“Name” refers to the name of the dye preset.

“Extraction / Emission Wavelength” refer to the barrier limits of the dye being used, and will adjust where in 
the spectrum of light the color should be if input.

“Color” refers to the color produced between the wavelength settings.

“New...” allows a user to create their own custom dye.

“Delete” removes a dye from the dye list.

“Save” allows the saving of a custom dye.

“Reset” moves the slider and wavelength settings back to the saved settings for that dye.

“Reload All” returns all dyes to their last saved settings.

“Close” exits the menu when complete.
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Options Menu Functions
Auto Correction Menu

The “Auto Correction” options menu enables the user to adjust the clipping strengths of the high and low end 
functions of the “Auto Level” and “Auto Contrast” quick filter functions. 
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Window Menu Functions
Window Menu

The “Window” menu contains useful tools in regards to the layout of the tabs in the viewing area, also called 
“windows.”

Close All - This function will return the viewing area to the default gray “empty” area as seen upon first loading 
the software by closing all other tabs and windows.

Reset Window Layout -  The “Reset Window Layout” function will return all tabs and windows to the top bar 
without closing them.

Windows... -  This brings up a custom menu, allowing users to choose windows to either activate as the cur-
rent window in view, save certain tabs, or simply close specific windows out.
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Troubleshooting

Common Issues
Symptom Cause Remedy

ISSUES
One side of the field 
of view is darker

The nosepiece is misaligned Turn the nosepiece until it clicks into place
Stains or dust has accumulated on the objective, 
eyepieces, or base lens

Clean all lenses with lens cleaner or a lint free non-
abraisive cloth

The port is not fully open If your microscope has a shutter or prism switch 
on it to open a trinocular port to allow light to the 
camera, remove the camera and check that the pin 
or switch is fully adjusted and fully attached. If not, 
please contact info@amscope.com with your SKU 
and order number for assistance and warranty in-
formation for your microscope.

Obstructions are 
observed in the field 
of view

Stains, dust, or dirt has accumulated on the 
specimen

Clean the slide or use a new specimen if sample is 
destroyed.

Stains, dust, or dirt have accumulated on a lens Clean both ends of the reduction lens and the lens 
on the camera body with lens cleaning solution 
and non-abrasive optical lens cloth.

Unclear Image Stains, dust, or dirt have accumulated on a lens Clean both ends of the reduction lens and the lens 
on the camera body with lens cleaning solution 
and non-abrasive optical lens cloth.

Stains, dust, or dirt have accumulated on a lens 
in the microscope

Remove the camera and use a can of compressed 
air to remove any dust, dirt, or debris from the 
port it sits in, and ensure any and all objectives are 
cleaned using lens cleaning solution and a non-
abrasive optical lens cloth.

The sample is not in focus Not all microscopes will have the camera and the 
eyepieces in focus at the same time, and may re-
quire refocusing while looking at the sample on the 
computer screen to ensure the camera view is fo-
cused. Adjustment must be done on the trinocular 
port (if adjustable) or the microscope’s main focus-
ing knobs.

One side of the field 
of view is dark or the 
image moves while 
focusing

The sample is not secured and centered under 
the microscope

Secure the sample to the stage.

The objective lenses of the microscope aren’t 
properly positioned or secured into place

Ensure that the objective lenses of your micro-
scope are locked into position.

The field of view is 
not bright enough

The microscope light is too dim Turn the dimmer dial or knob up on the micro-
scope’s illumination source, or use a stronger light.

The exposure setting is not set properly in the 
software

Turn “Auto Exposure” on, if it is not already on, and 
raise the “Exposure Target”. Alternatively, turn it 
off and adjust the “Exposure Time” setting.
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Troubleshooting

Common Issues (Continued)
Symptom Cause Remedy

ISSUES
The camera is not acti-
vating or detected

The camera is not plugged in Please ensure that a working USB cable is used to 
attach the camera to the computer in a powered 
USB 2.0 port. If still not detected or working, try 
replacing the USB cable, and reinstalling both 
driver and software.

The driver is not installed Please install the driver from the included soft-
ware CD or the www.amscope.com website.

Low frame rate USB version too low, resolution too high, expo-
sure time too high, frame rate setting not set to 
highest

Lower the live resolution, lower the exposure time 
and use more light from the microscope, and set 
the frame rate setting to the highest. If the frame 
rate is still too low, a USB3.0 device with a USB3.0 
port may be required, or the hardware (PC) might 
not be powerful enough.

Black image on screen Port on the microscope is closed Open the port/shutter where the camera is in-
stalled, or move to another port.

Cap is left on the camera/reduction lens Remove the camera from the port and wave it 
around the room while watching the screen. If 
no color change is seen, the camera has a cap on 
it. Remove reduction lens and camera body, and 
check all ends for caps/stickers. Remove and retry.

Light on microscope is not on Turn on the light from the microscope, or turn 
the intensity dial/knob higher. Ensure no caps are 
blocking the light path from the microscope.

Exposure is set too low Turn auto exposure on, or leave off and adjust the 
“Exposure Time” slider until the image is seen.

The image is inverted The microscope is a compound microscope, or 
the reduction lens is inverting the image

The “Horizontal” and “Vertical” flip functions un-
der “Flip” in the left navigation bar to correct for 
image inversions.

Cannot pick a unit of 
measurement other 
than pixels (px)

The camera software has not been calibrated for 
the desired measurement method yet

Please perform the calibration procedure out-
lined on page 140. The unit of measurement and 
magnification calibrated in that process will be 
selectable.
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Troubleshooting

Common Issues (Continued)
Symptom Cause Remedy

ISSUES
Error Message: Please 
calibrate in maximized 
size.

Calibration cannot be performed at a lower live 
resolution than the max resolution possible with 
the camera

Please set the live resolution to the maximum set-
ting the camera software allows before perform-
ing the calibration procedure.

Error Message: Insuf-
ficient Bandwidth

The USB port used with the camera is not 
USB2.0/3.0 (depending on camera model) and/
or powered

If using a high resolution setting with a USB3.0 
camera in a USB2.0 port, low frame rates may be 
experienced, however, if the port speed is too 
slow, the high resolution may not be supported 
due to insufficient bandwidth. Please use a USB3.0 
port with a USB3.0 camera, or lower the resolu-
tion. A USB2.0 device will behave the same if in a 
USB1.0 port, or in any unpowered port. 

The USB port on the computer or camera, or the 
USB cable, is defective/malfunctioning

Try using a different USB port on your computer, 
and if still providing an error, try a different USB 
cable with both already tested ports. If still mal-
functioning, try a different computer if available. If 
still malfunctioning, the likely culprit is the camera 
itself.

Error Message: Device 
has been pulled/
polled out

The USB port used with the camera is not 
USB2.0/3.0 (depending on camera model) and/
or powered

Use a compatible USB port that is the same type 
as your camera. Even though USB3.0 ports are 
backwards compatible, they tend to have issues 
resulting in errors. USB3.0 devices can be used in 
USB2.0 devices only with a loss of speed, however, 
it is still best to use the correct version. Also be 
sure that the ports are powered. Plug it directly 
into the computer in the rear USB.

The USB cable for the device and/or either port 
(computer case side or camera side) are malfunc-
tioning

Change the USB cable and see if that resolves 
the issue. If so, the cable was the issue. If not, 
try another USB2.0/USB3.0 powered port. If still 
encountering the issue, try a different computer.


